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Grouped Safety Messages

Make sure to read through and observe the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standard of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment required for them are designed and tested in accordance with the
relevant safety standards. Compliance with these standards is continuously monitored by our quality
assurance system. The product described here has been designed and tested in accordance with the EC
Certificate of Conformity and has left the manufacturer’s plant in a condition fully complying with safety
standards. To maintain this condition and to ensure safe operation, observe all instructions and warnings
provided in this manual. If you have any questions regarding these safety instructions, the Rohde &
Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for an intention other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and a basic knowledge of English. It is therefore essential that only
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at
the appropriate place in the product documentation. Keep the basic safety instructions and the product
documentation in a safe place and pass them on to the subsequent users.

Symbols and safety labels

A ASANAAGHRR L

Observe Weight Danger of Warning! Attention!

product indication for electric Hot PE terminal Ground tg:;lij:;jl Electrostatic
documentation units >18 kg shock surface sensitive devices

| O D e ~ _~ O

Supply Direct ) . . Device fully protected
voltage Standby current Alternating Direct/alternating by double/reinforced

ON/OFF indication (DC) current (AC) current (DC/AC) insulation

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before putting the product into operation. It is also absolutely essential to observe the additional safety
instructions on personal safety that appear in relevant parts of the product documentation. In these safety
instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & Schwarz
group of companies, including instruments, systems and all accessories.

1171.0000.42-04.00 Sheet 1



Grouped Safety Messages

Tags and their meaning

DANGER DANGER indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

WARNING WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION CAUTION indicates a hazardous situation which, if not avoided, may result in minor or
moderate injury.

NOTICE NOTICE indicates a property damage message.

In the product documentation, the word ATTENTION is used synonymously.

These tags are in accordance with the standard definition for civil applications in the European Economic
Area. Definitions that deviate from the standard definition may also exist in other economic areas or
military applications. It is therefore essential to make sure that the tags described here are always used
only in connection with the related product documentation and the related product. The use of tags in
connection with unrelated products or documentation can result in misinterpretation and thus contribute to
personal injury or material damage.

Basic safety instructions

The product may be operated only under the
operating conditions and in the positions
specified by the manufacturer. Its ventilation
must not be obstructed during operation.
Unless otherwise specified, the following
requirements apply to Rohde & Schwarz
products:

prescribed operating position is always with
the housing floor facing down, IP protection
2X, pollution severity 2, overvoltage category
2, use only in enclosed spaces, max.
operation altitude 2000 m above sea level,
max. transport altitude 4500 m above sea
level.

A tolerance of +10% shall apply to the
nominal voltage and of +5% to the nominal
frequency.

Applicable local or national safety
regulations and rules for the prevention of
accidents must be observed in all work
performed. The product may be opened only
by authorized, specially trained personnel.
Prior to performing any work on the product
or opening the product, the product must be
disconnected from the supply network. Any
adjustments, replacements of parts,
maintenance or repair must be carried out
only by technical personnel authorized by

1171.0000.42-04.00

Rohde & Schwarz. Only original parts may
be used for replacing parts relevant to safety
(e.g. power switches, power transformers,
fuses). A safety test must always be
performed after parts relevant to safety have
been replaced (visual inspection, PE
conductor test, insulation resistance
measurement, leakage current
measurement, functional test).

As with all industrially manufactured goods,
the use of substances that induce an allergic
reaction (allergens, e.g. nickel) such as
aluminum cannot be generally excluded. If
you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or
respiratory difficulties), consult a physician
immediately to determine the cause.

If products/components are mechanically
and/or thermically processed in a manner
that goes beyond their intended use,
hazardous substances (heavy-metal dust
such as lead, beryllium, nickel) may be
released. For this reason, the product may
only be disassembled, e.g. for disposal
purposes, by specially trained personnel.
Improper disassembly may be hazardous to
your health. National waste disposal
regulations must be observed.

Sheet 2
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Grouped Safety Messages

If handling the product yields hazardous
substances or fuels that must be disposed of
in a special way, e.g. coolants or engine oils
that must be replenished regularly, the safety
instructions of the manufacturer of the
hazardous substances or fuels and the
applicable regional waste disposal
regulations must be observed. Also observe
the relevant safety instructions in the product
documentation.

Depending on the function, certain products
such as RF radio equipment can produce an
elevated level of electromagnetic radiation.
Considering that unborn life requires
increased protection, pregnant women
should be protected by appropriate
measures. Persons with pacemakers may
also be endangered by electromagnetic
radiation. The employer/operator is required
to assess workplaces where there is a
special risk of exposure to radiation and, if
necessary, take measures to avert the
danger.

Operating the products requires special
training and intense concentration. Make
certain that persons who use the products
are physically, mentally and emotionally fit
enough to handle operating the products;
otherwise injuries or material damage may
occur. It is the responsibility of the employer
to select suitable personnel for operating the
products.

Prior to switching on the product, it must be
ensured that the nominal voltage setting on
the product matches the nominal voltage of
the AC supply network. If a different voltage
is to be set, the power fuse of the product
may have to be changed accordingly.

In the case of products of safety class | with
movable power cord and connector,
operation is permitted only on sockets with
earthing contact and protective earth
connection.

Intentionally breaking the protective earth
connection either in the feed line or in the

product itself is not permitted. Doing so can
result in the danger of an electric shock from
the product. If extension cords or connector
strips are implemented, they must be
checked on a regular basis to ensure that
they are safe to use.

If the product has no power switch for
disconnection from the AC supply, the plug

1171.0000.42-04.00

12.

13.

14.

15.

16.

17.

18.

19.

of the connecting cable is regarded as the
disconnecting device. In such cases, it must
be ensured that the power plug is easily
reachable and accessible at all times
(corresponding to the length of connecting
cable, approx. 2 m). Functional or electronic
switches are not suitable for providing
disconnection from the AC supply. If
products without power switches are
integrated in racks or systems, a
disconnecting device must be provided at
the system level.

Never use the product if the power cable is
damaged. Check the power cable on a
regular basis to ensure that it is in proper
operating condition. By taking appropriate
safety measures and carefully laying the
power cable, ensure that the cable cannot be
damaged and that no one can be hurt by e.g.
tripping over the cable or suffering an electric
shock.

The product may be operated only from
TN/TT supply networks fused with max. 16 A
(higher fuse only after consulting with the
Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are
dusty or dirty. Insert the plug firmly and all
the way into the socket. Otherwise, this can
result in sparks, fire and/or injuries.

Do not overload any sockets, extension
cords or connector strips; doing so can
cause fire or electric shocks.

For measurements in circuits with voltages
Vims > 30V, suitable measures (e.g.
appropriate measuring equipment, fusing,
current limiting, electrical separation,
insulation) should be taken to avoid any
hazards.

Ensure that the connections with information
technology equipment comply with IEC
950/EN 60950.

Unless expressly permitted, never remove
the cover or any part of the housing while the
product is in operation. Doing so will expose
circuits and components and can lead to
injuries, fire or damage to the product.

If a product is to be permanently installed,
the connection between the PE terminal on
site and the product's PE conductor must be
made first before any other connection is
made. The product may be installed and
connected only by a license electrician.
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20.

21.

22.

23.

24.

25.

26.

27.

Grouped Safety Messages

For permanently installed equipment without
built-in fuses, circuit breakers or similar
protective devices, the supply circuit must be
fused in such a way that suitable protection
is provided for users and products.

Do not insert any objects into the openings in
the housing that are not designed for this
purpose. Never pour any liquids onto or into
the housing. This can cause short circuits
inside the product and/or electric shocks, fire
or injuries.

Use suitable overvoltage protection to
ensure that no overvoltage (such as that
caused by a thunderstorm) can reach the
product. Otherwise the operating personnel
will be endangered by electric shocks.

Rohde & Schwarz products are not protected
against penetration of liquids, unless
otherwise specified (see also safety
instruction 1.). If this is not taken into
account, there exists the danger of electric
shock for the user or damage to the product,
which can also lead to personal injury.

Never use the product under conditions in
which condensation has formed or can form
in or on the product, e.g. if the product was
moved from a cold to a warm environment.

Do not close any slots or openings on the
product, since they are necessary for
ventilation and prevent the product from
overheating. Do not place the product on soft
surfaces such as sofas or rugs or inside a
closed housing, unless this is well ventilated.

Do not place the product on heat-generating
devices such as radiators or fan heaters.
The temperature of the environment must
not exceed the maximum temperature
specified in the data sheet.

Batteries and storage batteries must not be
exposed to high temperatures or fire. Keep
batteries and storage batteries away from
children. Do not short-circuit batteries and
storage batteries.

If batteries or storage batteries are
improperly replaced, this can cause an
explosion (warning: lithium cells). Replace
the battery or storage battery only with the
matching Rohde & Schwarz type (see spare
parts list). Batteries and storage batteries
must be recycled and kept separate from
residual waste. Batteries and storage
batteries that contain lead, mercury or
cadmium are hazardous waste. Observe the

1171.0000.42-04.00

28.

29.

30.

31.

32.

33.

34.

national regulations regarding waste
disposal and recycling.

Please be aware that in the event of a fire,
toxic substances (gases, liquids etc.) that
may be hazardous to your health may
escape from the product.

The product can be very heavy. Be careful
when moving it to avoid back or other
physical injuries.

Do not place the product on surfaces,
vehicles, cabinets or tables that for reasons
of weight or stability are unsuitable for this
purpose. Always follow the manufacturer's
installation instructions when installing the
product and fastening it to objects or
structures (e.g. walls and shelves).

Handles on the products are designed
exclusively for personnel to hold or carry the
product. It is therefore not permissible to use
handles for fastening the product to or on
means of transport such as cranes, fork lifts,
wagons, etc. The user is responsible for
securely fastening the products to or on the
means of transport and for observing the
safety regulations of the manufacturer of the
means of transport. Noncompliance can
result in personal injury or material damage.

If you use the product in a vehicle, it is the
sole responsibility of the driver to drive the
vehicle safely. Adequately secure the
product in the vehicle to prevent injuries or
other damage in the event of an accident.
Never use the product in a moving vehicle if
doing so could distract the driver of the
vehicle. The driver is always responsible for
the safety of the vehicle. The manufacturer
assumes no responsibility for accidents or
collisions.

If a laser product (e.g. a CD/DVD drive) is
integrated in a Rohde & Schwarz product, do
not use any other settings or functions than
those described in the product documen-
tation. Otherwise this may be hazardous to
your health, since the laser beam can cause
irreversible damage to your eyes. Never try
to take such products apart, and never look
into the laser beam.

Prior to cleaning, disconnect the product
from the AC supply. Use a soft, non-linting
cloth to clean the product. Never use
chemical cleaning agents such as alcohol,
acetone or diluent for cellulose lacquers.
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Certified Quality System

DIN EN ISO 9001
DIN EN 9100

DIN EN ISO 14001

DAS REG. NO 001954 QM UM

QUALITATSZERTIFIKAT

Sehr geehrter Kunde,

Sie haben sich fiir den Kauf eines
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein
nach modernsten Fertigungsme-
thoden hergestelltes Produkt. Es
wurde nach den Regeln unseres
Managementsystems entwickelt,
gefertigt und gepriift.

Das Rohde & Schwarz Management-
system ist zertifiziert nach:

DIN EN SO 9001:2000
DIN EN 9100:2003
DIN EN ISO 14001:2004

1171.0200.11-03.00

CERTIFICATE OF QUALITY

Dear Customer,

you have decided to buy a Rohde &
Schwarz product. You are thus as-
sured of receiving a product that is
manufactured using the most modern
methods available. This product was
developed, manufactured and tested
in compliance with our quality mana-
gement system standards.

The Rohde & Schwarz quality
management system is certified
according to:

DIN EN SO 9001:2000
DIN EN 9100:2003
DIN EN ISO 14001:2004

CERTIFICAT DE QUALITE

Cher Client,

vous avez choisi d‘acheter un produit
Rohde & Schwarz. Vous disposez
donc d‘un produit fabriqué d‘apres les
méthodes les plus avancées. Le
développement, la fabrication et les
tests respectent nos normes de ges-
tion qualité.

Le systéme de gestion qualité de
Rohde & Schwarz a été homologué
conformément aux normes:

DIN EN SO 9001:2000
DIN EN 9100:2003
DIN EN ISO 14001:2004

ROHDE&SCHWARZ

PD 5213.8744.99 -V 01.00 - May 2007



Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

USA & Canada Monday to Friday  (except US public holidays)
8:00 AM - 8:00 PM  Eastern Standard Time (EST)

Tel. from USA 888-test-rsa (888-837-8772) (opt 2)
From outside USA  +1 410 910 7800 (opt 2)

Fax +1410 910 7801

E-mail CustomerSupport@rohde-schwarz.com
East Asia Monday to Friday  (except Singaporean public holidays)

8:30 AM - 6:00 PM Singapore Time (SGT)

Tel. +65 6 513 0488

Fax +65 6 846 1090

E-mail CustomerSupport@rohde-schwarz.com
Rest of the World Monday to Friday  (except German public holidays)

08:00 - 17:00 Central European Time (CET)

Tel. from Europe  +49 (0) 180 512 42 42*
From outside Europe+49 89 4129 13776
Fax +49 (0) 89 41 29637 78

E-mail CustomerSupport@rohde-schwarz.com

*0.14 €/Min within the German fixed-line telephone network, varying prices
for the mobile telephone network and in different countries.

ROHDE&SCHWARZ

1171.0200.22-03.00
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Address List

Headquarters, Plants and Subsidiaries

Headquarters

ROHDE& SCHWARZ GmbH & Co. KG
Mihldorfstrake 15 - D-81671 Miinchen
P.0.Box 80 14 69 - D-81614 Miinchen

Plants

ROHDE& SCHWARZ Messgeratebau GmbH
RiedbachstraRe 58 - D-87700 Memmingen
P.0.Box 16 52 - D-87686 Memmingen

ROHDE& SCHWARZ GmbH & Co. KG

Werk Teisnach

Kaikenrieder StraRe 27 - D-94244 Teisnach
P.0.Box 1149 - D-94240 Teisnach

ROHDE& SCHWARZ zavod
Vimperk, s.r.o.

Location Spidrova 49
(CZ-38501 Vimperk

ROHDE&SCHWARZ GmbH & Co. KG
Dienstleistungszentrum Kéln
Graf-Zeppelin-StraBe 18 - D-51147 KdlIn
P.0.Box 98 02 60 - D-51130 KéIn

Subsidiaries

R&S BICK Moabilfunk GmbH
Fritz-Hahne-Str. 7 - D-31848 Bad Minder
P.0.Box 20 02 - D-31844 Bad Miinder

ROHDE& SCHWARZ FTK GmbH
WendenschloRstraRe 168, Haus 28
D-12557 Berlin

ROHDE& SCHWARZ SIT GmbH
Am Studio 3
D-12489 Berlin

R&S Systems GmbH
Graf-Zeppelin-StraRe 18
D-51147 KéIn

GEDIS GmbH
Sophienblatt 100
D-24114 Kiel

HAMEG Instruments GmbH

Industriestralle 6
D-63533 Mainhausen
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Phone +49 (89) 41 29-0
Fax +49 (89) 41 29-121 64
info.rs@rohde-schwarz.com

Phone +49 (83 31) 1 08-0
+49(8331) 108-1124
info.rsmb@rohde-schwarz.com

Phone +49 (99 23) 8 50-0
Fax +49 (99 23) 8 50-174
info.rsdts@rohde-schwarz.com

Phone +420 (388) 45 21 09
Fax +420 (388) 45 21 13

Phone +49 (22 03) 49-0
Fax +49 (22 03) 49 51-229
info.rsdc@rohde-schwarz.com

service.rsdc@rohde-schwarz.com

Phone +49 (50 42) 9 98-0
Fax +49 (50 42) 9 98-105
info.bick@rohde-schwarz.com

Phone +49 (30) 658 91-122
Fax +49 (30) 655 50-221
info.ftk@rohde-schwarz.com

Phone +49 (30) 658 84-0
Fax +49 (30) 658 84-183
info.sit@rohde-schwarz.com

Phone +49 (22 03) 49-5 23 25
Fax +49 (22 03) 49-5 23 36
info.rssys@rohde-schwarz.com

Phone +49 (431) 600 51-0
Fax +49 (431) 600 51-11
sales@gedis-online.de

Phone +49 (61 82) 800-0
Fax +49 (61 82) 800-100
info@hameg.de

Locations Worldwide

Please refer to our homepage: www.rohde-schwarz.com

@ Sales Locations
@ Service Locations
@ National Websites



1 Overview
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Acoustic Measurements on Mobile Phones

The acoustic transmission and reproduction quality of a mobile phone is its
most important characteristic in everyday use. Even the most visually
appealing design and wonderfully sophisticated operating concept are not
much use, when the user cannot or can hardly understand what is being said
at the other end.

Instruments and methods for measuring acoustic characteristics are therefore
essential tools for assessing the quality and suitability of a mobile phone.

Since a digital audio interface is no longer required even for type-approval tests
on 3rd generation mobile phones, it was necessary to develop new test methods
that allowed measurements to be performed via the air interface and the normal
speech coder and decoder. The test signals have to simulate human voice in the
frequency and time domain to be able to test the mobile phone in the normal
operating mode with DSP assessment such as voice activity detector (VAD),
noise suppression, echo cancellation, etc switched on.

These tests are based on new standards for 3GPP mobile phones. The test
methods are stipulated in 3GPP TS 26.132 and the values to be attained in 3GPP
TS 26.131.

As of release 4 of the GSM 51.010 standard (successor to GSM 11.10), even
GSM mobile phones may be tested to 3GPP TS 26.132.

The R&S UPV-K9 and R&S UPV-K91 options (UMTS/GSM Mobile Phone Tests)
of the Audio Analyzer R&S UPV, called herein below “UPV”, are now available for
measuring the acoustic characteristics of UMTS and GSM mobile phones. The
measurements are in line with 3GPP TS 26.131, TS 26.132 and TS 51.010 and
have been validated by an independent test house for type-approval testing on
UMTS and GSM mobile phones.



Acoustic Measurements on Mobile Phones

2 Preparation and Start of the Application Software

1402.0043.12

Required Measuring Instruments and Accessories

The Audio Analyzer R&S UPV with the following options is required for the
measurements:

e Base Software for Mobile Phone Tests R&S UPV-K9
e UMTS/GSM Mobile Phone Tests R&S UPV-K91
Note: The UPV firmware version must be 2.1.1.261 or higher.

The GSM mobile phone under test is connected via the RF interface using
the Universal Digital Radio Communication Tester R&S CMU200, called
herein below CMU 200. This tester simulates a base station for the mobile
phone so that a call can be set up. For GSM, the CMU200 must be
equipped with the options CMU-B21 (signalling unit), CMU-B52 (speech
coder/decoder) and the appropriate software options for the GSM band
used. For WCDMA (UMTS), the option CMU-B69 is required. Wideband-
AMR tests require option CMU-K46 for both GSM and/or WCDMA (UMTS).

Note: The firmware level in the CMUZ200 must be 4.52 or higher.

Acoustic devices such as an artificial mouth, artificial ear and other
accessories are required for the measurements. The following equipment
from Briiel & Kjaer or G.R.A.S. is normally used:

Device

Description

Type (examples)

Telephone test head

Device for fixing the DUT in the
prescribed position

B&K 4602B

Wideband ear simulator

IEC 711 type occluded ear simulator
with adapters for connection to the
ear piece of the DUT

B&K 4195 (type 3.2)

Artificial mouth

Special loudspeaker for simulation
of the mouth

B&K 4227 or
G.R.A.S. 44AB or
44AA (with power
amplifier)

Head and torso simulator

Head and torso simulator with
artificial ear (type 3.3) and artificial
mouth, may be used alternatively to
the abovementioned devices

B&K 4128 D

Handset fixture for Head
and Torso simulator

Required to position the handset on
the artificial head, and to apply a
defined force with the earpiece
against the pinna

Measurement microphone

2" or ¥4 measurement microphone
for measurement of artificial mouth
output during calibration. This
microphone can use the preamplifier
of the artificial ear.

B&K4191 (free field,
may be used for
hands free tests),
B&K 4192 (pressure
field, may be used
with type 1 art. ear)

Acoustic calibrator

Sound level calibrator for calibrating
the measuring microphone

B&K 4231

Microphone power supply

Power supply and preamplifier for
the measuring microphone

B&K 2829, 5935L or
2690A0S2

or G.R.A.S. 12AD or
12AA
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Note: With the amplifier set to 0 dB, the microphone power supply B&K
2690A0S2 produces too much noise for measuring idle noise and
distortion. It is therefore advisable to set a gain of 20 dB.

A cable with a BNC connector and special small or angled banana plugs is
required for connecting the artificial mouth, as the space between the
mouth connectors and the LRGP test head (B&K 4602B) is too small for
common banana plugs.

The transformer supplied with option R&S UPV-K9 must be connected
between generator output 1 of Audio Analyzer R&S UPV and the connector
of the artificial mouth. The transformer matches the impedance of the
loudspeaker in the artificial mouth to that of the generator output of the
R&S UPV. Without this transformer, the available power is too low for
driving the artificial mouth.

Alternatively, a power amplifier, preferably with a voltage gain of approx.
0 dB, can be connected between generator output and mouth instead of the
transformer. In this case, the gain set must be kept absolutely stable after
calibration.

A cable with male (analyzer) and female (generator) XLR connector is
supplied for connection to the "Speech" connector of the Digital Radio
Communication Tester CMU.

UPV Analyzer Generator

Fig. 1 Assignment of 9-contact speech connector on CMU front panel

This cable is configured for connection to link handler #1 in the CMU.
Depending on the CMU hardware, link handler #2 in the CMU can also be
used for GSM; in this case, the supplied adapter must be inserted between
the cable and the speech connector on the CMU.

Note: If the CODEC calibration fails, the adapter has most likely to be
inserted.
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Note: The CMU connects pin 1 of the R&S UPV generator output to
the equipment grounding conductor of the mains. If an external
power amplifier is used, care must be taken that the external
power amplifier does not connect R&S UPV generator output pin
2 to the equipment grounding conductor of the mains. If
available, a balanced connection to the power amplifier should
be preferred.

Attention: An external power amplifier should be switched on after the
R&S UPV-K9x program has been started, and switched off
before the program is ended. This prevents the artificial mouth
from undue power loading by setups which are loaded external
to the application.

Note: An external USB keyboard and a mouse must be connected to
the R&S UPV.

Caution: R&S UPV-K9x does not support the use of headphones. Do not
connect headphones to the R&S UPV during mobile phone
tests. High level signals may be present at the headphone
connector.

The program required and the associated files are in the folder “UPV-K9x
Software” on the installation CD supplied with the R&S UPV-K91 option.
The audio analyzer must meet the following firmware requirements:

e R&S UPV firmware version 2.1.1.261 or higher
e Option R&S UPV-K9 installed
e Option R&S UPV-K91 installed.

Installing the Software

The application program requires option keys K9 and K91 to be installed.
The keys are installed in the factory in case a new R&S UPV is ordered
together with these options. If the options are ordered separately, the keys
as well as the installation manual are part of the delivery.

It is recommended to copy the files UPV-K9x.msi, Config.ini, dotnetfx.exe,
Setup.exe and Settings.ini from the folder “UPV-K9x Software” on the
installation CD to drive D: on the R&S UPV hard disk drive, e.g. to a folder
named “D:\R&S Software\UPV-K9x\Version x.y”. Run the file “Setup.exe” to
start the installation. Follow the instructions of the installer on the screen.

To have full control over minimized windows, it is recommended to set the
windows taskbar to “Auto-hide”, on top of other windows. Right-click on the
Windows Start button and click “properties”.

Open
Explore

Search. ..

Properties

Cpen All Users
Explore All Users

It.‘Sl:a'l'tH = o390

Fig.2  Context menu for taskbar
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In the properties window, click tab “Taskbar” and activate “Auto-hide the
taskbar” and “Keep the taskbar on top of other windows”. Click “Apply” and
close the window.

Taskbar and Start Menu Properties |

Taskbar I Start ke I

— Taskbar appearance

[ Laock the taskbar
¥ &uto-hide the taskbar
¥ Keep the taskbar on top of other windows

¥ Group similar tagkbar buttans
¥ Show Quick Launch

— Matification area

(¢ )llne 1:23 PM

¥ Show the clock

Y'ou can keep the notification area uncluttered by hiding icons that wau
hawve not clicked recently.

¥ Hide inactive icons Customize... |
k. I Cancel | Apply |

Fig. 3 Properties window for taskbar

Test Setup
1 Microphone
; Supply
O O P
art ear
l
Transformer DQ
rorstm}—
art mouth

]
0
]
]
]
]
]
]
0

‘B:IIIIIIIII

RF to Mobile

Fig.4  Test setup and connection of external components
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Starting the Application Software

After installation, the program can be started by double-clicking the Icon
“UPV-K9x Mobile Phone Tests” or by clicking “R&S UPV Applications >
UPV-K9x Mobile Phone Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the standard
according to which the measurements should be made, and for the artificial
ear and artificial mouth used.

Select Standard

none 3GPF TS526.132 HHHF narrow
AGFP TS51.0010 Type 1 ear AGPP T526.132 HHHF wide
3GPP T526.132 handset narrow 3GPF T526.132 DTHF narrow
3AGFP TS5 26.132 handzet wide 3GFPP T526.132 DTHF wide
Mon-standard handset Mon-standard hands free

¥ Allow only selected measurements

Cancel | )3

Fig. 5  Query window for selection of applied standard

If “none” is selected in the standard selection window, all measurements
appear in the “Measurement” menu. If a standard is selected, all
measurements appear in the “Measurement” menu, but compliant
measurements are checked in the menu. If “Allow only standard
measurements” is checked, non-compliant measurements are suppressed
in the Measurement menu. “Non-standard handset’” and “non-standard
hands free” select handset or hands-free tests, respectively, which can be
customized.

10 E-2
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Select Ear Simulator

Type 1

Type 3.2 Low Leak,

Type 3.2 High Leak

Type 2.3

Type 2.4

Electnz connection

| nduction coil

[T Do not show this dislog again

Cancel | k. I
y

Fig. 6  Query window for selection of artificial ear

®5elect mouth type  [H[=]

LRGP ITU-T P.51

HATS ITU-T P.58

Genenc speaker

Electnz connection

[T Do not show this dislog again

Cancel | k. /L
2

Fig. 7 Query window for selection of artificial mouth

When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu (see
below). After the last of the three selection windows has been closed, the
main window of the R&S UPV-K9 opens.
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@Telephnne Tests =] |

File Data Calibration Measurement Sequence Report Options Help

Testresults overdiew

Date and time | Measurement title | Test object | Werdi | Camment =
| |9/8/2008 3:17:26 P 3GPP Receiving Handset, nom. Yal Test mobile & PASS
| |9/8/2006 37813 PM 3GPP Ide channel noize receiving. nom, wol. Test mobile & PASS
| |9/8/2006 31832 PM 3GPP Sidetone Masking Rating Test mobile & FAIL
| |9/8/2006 31310 PM JGFPP Distortion receiving Test mobile & PASS
| |9/8/2006 3:20:10 P 3GPP Sending Handset Test mobile & Pass
| |9/8/2006 3:20:43 P 3GPP Distortion sending Rel. & Test mobile & Pass
| |9/8/2006 3:21:51 P 3GPP |dle channel noise sending Test mobile & PASS
| |9/8/2006 3:22.43 Pt 3GPP Receiving Handset, min. Vol. Test mobile & PASS
| |9/8/2006 3:2511 PM 3GPP Receiving Handset, max. Vol Test mobile & PASS
| |9/8/2006 3:25:42 PM JGFPP Ide channel noise receiving. max. vol. Test mobile & PASS
| |9/8/2006 3:27:07 PM 3GFPP Echo loss with braining Test mobile & PASS
| |9/8/2006 3:2814 PM 3GPP Stability margin Test mobile &4 PASS
| |9/8/2006 4:0514 Pt 3GPP G5M Rel. 4 Receiving Handset, nom. % | Test mobile B PASS
| |9/8/2006 4:16:23 P 3GPP Sidetone Masking Rating Test mobile B PASS
| |9/8/2006 41338 PM 3GPP Ide channel noize receiving, nom, wol. Test mobile B FAIL
| |9/8/2006 4:20:01 PM 3GPP Distortion receiving Test mobile B PASS
| |9/17/2006 5:42:48 PM 3JGPP Receiving Handset, nom. Yol Sample test object FAIL
| |9/11/2006 5:45:06 PM 3GFPP Ide channel noize receiving, nom. wol Sample test object PASS
| |9/11/2006 5:47:31 PM 3GPP Receiving Handset, max. Yol Sample test object Pass
| |9/11/2006 5:45:03 PM 3GPF Idle channel noize receiving, nom. wal. Sample test object Pass
| |9/11/2006 5:45:54 PM 3GPP Distortion receiving Sample test object PASS
| |9/17/2006 5:50:50 PM 3GPP Echo loss with training Sample test object PASS
| |9/17/2006 5:54:40 PM 3GPP Echo loss with braining Sample test object PASS |
| |3/11/2006 55712 PM 3JGPP Sidetone Masking Fating Sample test object FAIL
| |3/11/2006 5:58:33 PM 3GPP Sending Handset Sample test object PASS
| |9/11/2006 B:00:22 PM 3GPP Distortion sending Rel. & Sample test object Pass -
01 NNE C- 770 Dhd VRO | Al sl i i C el bk mbimek Dacc
< |

3GPPHands Nanow | Type 32 Low Leak AEar |CMU / CRTU
| | Report lagt

Sample test object

measurement sequence

| Report lagt

Fig. 8 Main window

Initially the data grid in the center of the screen which shows the result
overview is empty. The screenshot below shows an example after a
number of measurements have been made.

By marking one of the results and clicking with the right mouse button on it,
a context menu opens which allows to create a report of this result, delete
the result or to export one of the curves in the result graph to an ASCII
format.

Delete Selected Row
Save icurve of Selected Row as ..,

Fig. 9  Context menu of the result data grid

1402.0043.12 12 E-2
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3 Operating Concept

1402.0043.12

R&S mobile phone tests consist of at least two components. R&S UPV-K9
provides the main user interface window, general settings, calibration
routines, data handling, automatic sequencing and reporting tools.

Separate options for different standards (R&S UPV-K91 for 3GPP GSM
and WCDMA tests) provide test macros for basic measurement types
defined in the standards. Each measurement type provides a set of
parameters (R&S UPV setup files, limits etc.) which are defined in
separated measurement definition files, one for each test case.

Options (General settings)

Options  Help

| Measurement freguency range
Standard
Select standard at starkup
Ear Sirmulakor
Select ear simulator at skartup
Artificial rnouth
Select artificial mouth at skartup
Syskem simulakor
Hands free settings

v Show operakor instructions

Report settings
Generakte kemporary export Files
Store results of further measurements
Store loaded curve data ko results

Fig. 10  Options menu

The “Options” menu in the main window allows to change a set of general
settings like ear type and mouth type used which are valid for all or at least
a plurality of the tests.

“Measurement frequency range” allows to enter the frequency range in
which the artificial head is calibrated. In general this will be 100 Hz to
10 kHz which is the default. “Number of points” specifies the number of
(logarithmically spaced) frequencies measured for the mouth equalization.

“Standard” allows to select one of the available standards. Measurements
belonging to this standard will be checked in the measurement menu. If
“Allow only standard measurements” is checked, it is not possible to start
single measurements which do not belong to the standard.

If “Select standard at startup” is checked, the selection window for the
standard is opened at each start of the program.

“Ear simulator” allows to select the type of ear simulator used. For details
on the handling of calibration data see section 4 “Calibration” below.

If “Select ear simulator at startup” is checked, the selection window for
the ear simulator is opened at each start of the program.

“Artificial mouth” allows to select the type of artificial mouth used. For
details on the handling of calibration data see section 4 “Calibration” below.

13 E-2
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If “Select artificial mouth at startup” is checked, the selection window for
the artificial mouth is opened at each start of the program.

“System simulator” allows to select the type of system simulator used.
For details on the handling of calibration data see section 4 “Calibration”
below.

“Hands free settings” allows to select the acoustic instruments used for
hands free testing. It is possible to use an ITU-T P.51 artificial mouth
together with a free field microphone, a HATS with one artificial ear or a
HATS with two artificial ears. If two artificial ears are used, the decoder has
to be disconnected from analyzer input 2 and the second artificial ear has to
be connected to it for receiving measurements. Do not forget to re-connect
the decoder for any measurement in sending direction.

If “Show operator instructions” is checked, instructions to the operator
are displayed in a window before the measurement starts. The operator
may be prompted to position the mobile in a defined way or to set the
volume to a certain setting.

“Report settings” allows to define the type of information which should
appear in the reports. For details on reporting, see section 8 below.

If “Generate temporary export files” is checked, each measurement
macro created “result.exp” with result value and verdict, and, if applicable,
“curve.exp” or “abscurve.exp” and “relcurve.exp” files with curve data in
ASCII format.

If “Store results of further measurements” is checked, curves and
calculated values like loudness ratings are also stored for additional
measurements started with the “Add Measurement” key. They will appear in
reports of the respective measurements.

If “Store loaded curve data to results” is checked, curves loaded from file
with the “Load Curve” softkey are stored to the results database and will
appear in reports of the respective measurements.

Attention: Do not attempt to modify files with extensions “set”, “sup”, “xml’,
“cal” “seq” or “mdf”, using a text editor. Any change with a text
editor may make the files unusable and cause malfunction of the
Software.
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4 Calibration

Calibration Devices

R&S UPV-K9 allows to simultaneously store calibration values for multiple
individuals of the same type. This allows to switch devices without the
requirement for re-calibration. However, regular re-calibration is
recommended in order to assure the correct function of the used devices.

D UPY-K9x Mobile Phone Tests (D, 3GPPLR

File Data | Calibration Measurement  Sktandarc

Seleckive
Microphone »
Artificial Ear k
DRP ko ERP correction k
Free field equalization »
3
3

artificial PMouth

artificial Mouth (Hands Free)
Zodec

Induction coil

Electric connections L4

Ambient noise Figld

MNew Device
Seleck Device

Show all walues

Show selected devices

Fig. 11  Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens an
entry window to specify the calibrated device. A category of device must be
chosen from the combo box on top. Type, manufacturer and serial number
are entered into the text boxes below. The entries are confirmed by clicking
on the “Save and close” button. If the box “Immediately select this device” is
checked, the device is selected for immediate use with the “Save, select
and close” button.

1402.0043.12 15 E-2
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Calibrated Deyice

Uzage

| =l
Type

b arufacturer

Senal Hurmber

[T Immediately select this device

Cancel | | Save and cloze

)

Fig. 12  Input window for information about calibrated device

Before a device can be calibrated or used, it must be selected. This can be
done from the “Calibrated Device” input window if the checkbox
“Immediately select this device” is checked. Existing devices may be
selected with “Calibration - Select device” in the main menu. Clicking on
this item opens a window with a table of all entered devices.

Select Calibrated Devices

¢ | Manufacturer | Type | SerialNa. | Dats and Time | Calib. value | File name |
4 & Default 08/25/2007 17:21 [rull] D:NIGPPYCa
Decoder Default 0741342006 17.50 [rwall) [D:M3GPPYCa
Diffuse field microphone Default 07/13/2006 17.57 [rwall) [:MN3GPPYCa
Electric connection replacing decoder Default 07/13/2006 17.54 [rull) D:M3GPPYCa
Electric connection replacing ear Default 1041142007 11:36 [rwall) D:M3GPPYCa
Electiic connection replacing encoder Default 07/13/2006 17.54 [rull] [ \3GPPACa
Electric connection replacing mouth Default 07413/2006 17:51 [rwall) [:MN3GPPYCa
Encoder Default 07413/2006 17.51 [rull) D:M3GPPYCa
Free field microphone Default 0B/07/2006 15:50 [rwall) D:M3GPPYCa
Genernic speaker Default 07/13/2006 16:33 [rull] [ \3GPPACa
HATS ITU-T P.58 At Mouth Default 0B/07/2006 15:47 [ruall] D:3GPPYCa
HATS Type 33Am Ear Default 0B/07/2006 15:52 [ruall] D:\3GPPYCa
HATS Type 3.4 Art. Ear Default 06/07/2006 15:54 [rull] D\ 3GPPACa
Induction coil [input] Default 07/13/2006 18:04 [rull] [ \3GPPACa
Input digital Default 0B/07/2006 15:43 [ruall] D:3GPPYCa
LRGP ITU-T P.51 At Mouth Default 07/13/2006 17:69 [ruall] D:\3GPPYCa
Output digital Default 0B/07/2006 15:50 [rwall) D:M3GPPYCa

Second Type 3.3 At Ear Default 07/11./2007 15:09 [rull] D:A3GPPYCa |
Second Type 3.4 At Ear Default 07411/2007 15:09 [rwall) [:MN3GPPYCa
Type 1 A Ear Default 06407 /2006 15:51 [rull) D:M3GPPYCa

7l Tupe 3.2 Hioh Leak ArtEar D efault OB/07 /2006 15:51 Tl | D436 PP\EJLI

IEeIecl uzage type first! j Sl | Cancel | Ok I

Fig. 13 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category. At
first startup, there is only a “Default” device for each category, but when
more devices have been created with the “New device” function, a choice
will be available in this view. In this state a row in the table can be marked
with a mouse click on its left end. A mouse click on the button “Select’
selects this device for the associated usage.
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®Eelett Calibrated Devices _ (O] x]
Usage L | b anufacturer | Tppe | Serial Mo. | [Diate and Time | Calib. walue ‘ File name
Type 3.2 Low Leak ArtEar BEK 4195 1708754 9/8/2006 5:07 P [ruall] D:A3IGPPYCal33:
Type 3.2 Low Leak AtEar Default 9/8/2006 3:.08 P -16.8484 2729569 DAIGPPSCal3sl
Type 3.2 Low Leak AtEar G.R.AS RA005E & RA | 26740 & 4636 | 9/8/2006 5:17 P [rwll] D:AIGPPSCal33]

Select | Cancel | Dk I

Fig. 14  Selection window for particular device type

Subsequently this procedure may be repeated for other categories. Finally
all selections are confirmed by clicking the “Ok” button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for
the R&S UPV-K9 option are stored independently of other options.

All calibration routines below require as pre-requisite that a device for the
respective usage has been generated and selected.

To simplify the procedure for the case that it is not intended to use multiple
devices of the same category nor to include information about the used
devices into a report, there is a “Default” device selected for each device
type or category after the first start of the program.

An overview of all selected calibration devices together with the calibration
values is given under the menu item “Calibration - Show selected
devices”.
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Microphone Calibration
> Insert the measuring microphone fully into the adapter of the sound
level calibrator and switch on the calibrator.

Note: After inserting the microphone, wait about 10 s to allow for
static pressure equalization.

> Call the test routine with “Calibration > Microphone - Free field” or
“Calibration = Microphone - Diffuse field” from the main menu,
depending on the microphone.

Microphone calibration

Connect microphone 1o analyzer input 1.
Insert microphone into calibrator using
adapter UC0210 and switch on calibrator.

[ Calibration level increazed by 20 dB [hot walidated]

Cancel | Ok

Fig. 15 Initial window of microphone calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in the
calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa) . If a
conditioning amplifier with 20 dB gain (recommended value) is used, the
displayed sensitivity must be about 10 times higher (e.g. 120 mV/Pa). If the
voltage measured is below 3 mV, an error message is displayed. Possible
error sources are, for example, a switched-off microphone power supply or
a disabled calibrator. In this case, the program requests that the test be
repeated. After switching on the microphone power supply, wait approx.
20 s before starting the calibration again.
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Calibration of Artificial Ear

Prior to the measurements, the absolute sensitivity of the microphone in the
artificial ear must be determined using a sound level calibrator such as the
Briel & Kjeer 4231 with a sound pressure level of 94 dBSPL or a sound
pressure of 1 Pa at 1 kHz.

Calibration of Ear Type 1
> Switch off the microphone power supply.

Attention: The 200 V polarization voltage of the microphone may cause
a slight electric shock. The current is harmless, but the
microphone preamplifier may be damaged.

» Remove the microphone from the artificial ear.

> Screw back the microphone capsule and switch on the operating
voltage.

> Insert the microphone fully into the adapter of the sound level
calibrator and switch on the calibrator.

Note: After inserting the microphone wait about 10 s to allow for
static pressure compensation.

> Select “Calibration > Artificial ear > Type 1” from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in
the calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa) . If
a conditioning amplifier with 20 dB gain (recommended value) is used,
the displayed sensitivity must be about 10 times higher (e.g.
120 mV/Pa). If the voltage measured is below 3 mV or fluctuating by
more than 0.2 dB, an error message is displayed. Possible error sources
are, for example, a switched-off microphone power supply or a disabled
calibrator. In this case, the program requests that the test be repeated.
After switching on the microphone power supply, wait approx. 20 s
before restarting the calibration.

The reference value measured is stored in a file on the hard disk and
used for all subsequent measurements when the same artificial ear type
1 is used as currently selected.

Calibration of Ear Type 3.2 Low Leakage

> Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

> Select “Calibration > Artificial ear > Type 3.2 Low Leak” from the
main menu.
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For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.2L:

The frequency response of the artificial ear of type 3.2L is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_LL.ADA” from the manufacturer’s calibration disk to a

USB stick or a CD-ROM or make this file available on a network drive via
LAN.

Call the routine “Calibration > DRP to ERP Correction - Type 3.2 Low
leak”. Browse to the file “OES_LL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.2 High Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

Select “Calibration > Artificial ear > Type 3.2 High Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2H is
used as currently selected.
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Reading the Calibration Data of the Artificial Ear of Type 3.2H:

The frequency response of the artificial ear of type 3.2H is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

» Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_HL.ADA” from the manufacturer’s calibration disk to a
USB stick or a CD-ROM or make this file available on a network drive via
LAN.

» Call the routine “Calibration - DRP to ERP Correction - Type 3.2 High
leak”. Browse to the file “OES_HL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.3

» Connect the sound level calibrator tightly to the artificial ear using the
adapter UA-1546 and switch the calibrator on.

> Select “Calibration > Artificial ear > HATS Type 3.3” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.3 is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.3:

Call the routine “Calibration > DRP to ERP Correction > Type 3.3
—>From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.4

> Remove the pinna and the ear canal simulator, connect the sound
level calibrator tightly to the artificial ear using the short steel adapter
and switch the calibrator on.
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> Select “Calibration > Artificial ear > HATS Type 3.4” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.4 is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.4:

Call the routine “Calibration > DRP to ERP Correction > Type 3.4
- From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “3GPP” directory has been renamed or removed.

Calibration of Artificial Mouth for Handset Tests

Before a mobile phone can be tested, the absolute sensitivity and frequency
response of the artificial mouth have to be measured and corrected with the
aid of a previously calibrated free-field or diffuse-field (pressure-field)
microphone. The measuring microphone removed from artificial ear type 1
can be used for this purpose or an additional microphone capsule is
screwed to the microphone preamplifier. The standard microphone is used
as a reference for determining the frequency response of the mouth. The
frequency response of the microphone can be ignored in the test frequency
range (100 Hz to 8 kHz) (see also calibration certificate of microphone
capsule).

Since interfering sound falsifies the corrections, the artificial mouth must be
calibrated in the sound-proof test chamber.

First of all, the measuring microphone has to be calibrated.

> Select a reference microphone type with “Calibration 2> Artificial
mouth - Select reference mic”.

For the selected microphone type, a device must be selected and
calibrated (see above). This device must be connected to R&S UPV
analyzer input 1 via power supply/conditioning amplifier.

If the selected reference microphone is a diffuse field type (e.g. B&K
4131 or 4134) or a microphone from a Type1 artificial ear, fit the
microphone at right angles to the mouth at the mouth reference point
(MRP) using the gauge supplied with the mouth (positioning at right
angles is necessary because diffuse field or pressure-calibrated
microphones have a flat frequency response to sound from random
incident direction and therefore exhibit an emphasis on high frequencies
with frontal sound incidence).
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If the selected microphone is a free field microphone, it must be
mounted in the axis of the sound outlet of the artificial mouth.

> Call the calibration routine with “Calibration = Artificial mouth >
LRGP ITU-T P.51” or “Calibration = Artificial mouth > HATS ITU-T
P.58” from the main menu.

The sound pressure generated at the MRP is set to exactly -4.7 dBPa in an
automatic measurement routine at 1 kHz. The generator voltage required is
stored in a file on the hard disk and used as a reference for all subsequent
settings with the same artificial mouth. If the sound pressure cannot be
adjusted to -4.7 dBPa, an error message is displayed with a request to
check the connection of the artificial mouth and to repeat the measurement.
A possible error source would be that the transformer supplied is not
connected between the generator and the artificial mouth.

The uncorrected frequency response of the artificial mouth is measured
and displayed. Next, the frequency response is measured with the
inverse frequency response correction automatically selected in the
generator (equalization). Residual errors caused by nonlinearities of the
speaker in the mouth are measured and taken into account in the final
equalization file as fine correction.

To verify the results, the absolute sound pressure versus frequency is
measured at a sound pressure of 4.7 dBPa (reference value for most of
the measurements). The absolute sound pressure at each frequency
must be within a tolerance band of +0.2 dB. Correct calibration without
interfering sound yields an almost straight line in the middle between the
two limit lines.

Calibration of CMU Speech Coder

The calibration of the speech coder and decoder is necessary to be able to
calculate absolute loudness. Calibration has to be performed only once and
must be repeated only if the CMU used is replaced. If the CMU is equipped
with model 14 of the Link Handler CMU-B21, GSM as well as WCDMA use
the same paths. Calibration of the coder is therefore identical for both
operating modes and need not be repeated when switching from GSM to
WCDMA or vice versa.

If GSM and WCDMA and use different link handlers, separate calibration
devices have to be generated for the two link handlers (i.e. with and without
the supplied adapter).

Note that encoder and decoder are handled as separate devices but
calibrated with one routine.

Auxiliary settings required for calibration can be found in the CMU under Bit
Stream (for GSM) and under BS Signal, Dedicated Channel, Voice settings
(for WCDMA) (firmware version 4.52 or higher). Call the calibration routines
with “Calibration - Codec” from the main menu.
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The following information is displayed:

Eskablish call and set 'Bit Stream’ to 'DecoderCal'l

Fig. 16 Message box during decoder calibration

Set up a call to the mobile phone. Set bit stream or voice setting on the
CMU to "Decoder Cal" and then click the “OK” button.

The actual voltage at the decoder output of the CMU is now measured for a
digital full-scale signal and the required correction value is calculated and
saved in the R&S UPV. The following request is then displayed:

Set 'Bit Stream’ ko ‘EncoderCal'l

Fig. 17 Message box during encoder calibration

After the “OK” button has been clicked, the input sensitivity of the speech
coder is measured and the input voltage required for digital full scale is
measured at the speech coder and saved in the R&S UPV.

Calibration of Ambient Noise Field

For the calibration of the noise field for ambient noise rejection tests, all
obstacles (test head or HATS, Telephone etc.) have to be removed from
the test chamber. For the generation of the noise field, additional equipment
is necessary. The noise field should have sufficient homogeneity (sound
pressure level independent of place) and diffuseness (randomly incident
sound at the place of the microphone). This can either be achieved in a
reverberation room with omni-directionally radiating sound source or in an
anechoic room with a number of uncorrelated noise sources. Limited
homogeneity can be achieved in the centre between two speakers. For
good diffuseness a minimum of four speakers distributed in different spatial
directions are required.

A diffuse field or pressure field microphone must be positioned at the spot
of the mouth reference point of the (removed) test head or HATS.

The menu ltem Calibration - Ambient noise field opens the following
window:
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®3l3 Ambient Noise Adjustment

I [=]
Mo Standard |Diffuse field microphone | CHU / CRTU | I
Adjust | Stop Start Enter
Spectium Adjust Level selustment ey ETTEr Change Scals [Ereate HEpart Close

Fig. 18 Measurement window for ambient noise field calibration.

The button “Adjust Spectrum” starts a continuous spectrum measurement
which allows to adjust the spectrum of the noise, e.g. using equalizers. The
template is centred around the curve irrespective of the absolute level.
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Fig. 19 Measurement window for spectrum adjustment.
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The continuous spectrum measurement can be aborted by clicking “Stop
Adjustment”.

The button “Adjust level” starts a continuous level measurement. If a
multitude of sources is used, each source must produce a sound pressure
level of -24 dBPa — 3 * LOG n dB, whereby n is the number of noise
sources.

<3G Ambient Noise Adjustment _[a[=]

Coarse dBPalA) Fine

Mo Standard [Ditfuse fiskd microphone  |CMU # CRTU [ I

Aiist
S

Start.

Stop Erer
Adjustment I sl el

| A st levE] Cammment

| [EHarae Seale [Ereate Hepart (Slose

Fig. 20 Measurement window for level adjustment.

The left thermometer column gives a coarse overview. The right column
has an enlarged scale for fine adjustment.

The continuous level measurement can be aborted by clicking “Stop
Adjustment”.

Once the noise field has been adjusted, the result can be documented by
pressing “Start Measurement”. Although there is no calibration value to be
used in the ambient noise rejection measurement, the level is stored and
can be included for reference in the measurement report.
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3G Ambient Noise Adjustment O]
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Fig. 21 Result of ambient noise calibration.
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Operator

Under “Data->Operator” an operator’'s name can be entered which is stored
in association with all calibration and measurement results. If “Operator” is
activated in the report settings, the name will appear in all reports about
these measurements.

Test object

Under “Data - Test object > New” a description of the device under test
can be entered.

Test Objeck

M ame

|
Type

M anufacturer

Senal Humber

[ Immediately select this test object

Cancel | | Save and cloze

b

Fig. 22 Window for input of information about a test object

If the checkbox “Immediately select this test object” is checked, the test
object associated with the entered data is automatically selected upon
closing the window. The data of this selected test object will be stored in
association with all measurements and appear on the associated reports if
“DUT information” is activated in the report settings.

A previously entered test objects can be selected with “Data > Test object
- Select”.
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General

Special problems caused by the coding and decoding algorithms of mobile
phones are encountered when measuring acoustic characteristics.
Vocoders are used to attain the lowest possible data rate. Mobile phone
voice codecs are optimized for transmitting human speech with low data
rate. Not the actual voice signals but only the filter and fundamental
parameters required for signal reconstruction are transmitted.

Purely sinusoidal tones normally used for audio measurements cannot be
transmitted with such a system. Therefore, the coder and decoder had initially
been excluded from the measurement, which required a specially prepared
test mobile phone with a specific test interface.

In commercially available mobile phones, this interface is not accessible;
measurements during normal operation can therefore only be performed via
the air interface with the speech coder and decoder included. With 3rd
generation mobile phones a digital audio interface is no longer provided
even for type-approval testing. As mentioned above, measurements using
sinusoidal tones cannot be performed because the static sinusoidal input
signal becomes a more or less stochastic output signal as a result of
coding, particularly in the medium and high audio frequency ranges.

Signals similar to voice therefore have to be used for the measurement, i.e.
either artificial voice according to ITU-T P.50 or a multitone signal according to
ITU-T P.501 is possible. At the same time, modulation of the signal in time must
largely correspond to voice, since many modern mobile phones use algorithms
for interference suppression which use the modulation to distinguish the useful
from the interfering signal.

The test routines in the R&S UPV-K91 use an amplitude-modulated multitone
signal according to ITU-T P.501 as described in 3GPP TS 26.132.

Starting measurements

Measurements can be started from the “Measurement” menu. This menu
contains either all available measurements, or the measurements belonging
to the selected standard if the checkbox “Allow only selected
measurements” in the “Options = Select standard” window is checked.

The menu “Standards” allows to start any measurement, whereby the
measurements are structured into submenus according to the standards to
which they belong. This allows a quick and easy access to all available
measurements.

29 E-2



Acoustic Measurements on Mobile Phones

Standards Config. Meas, Seguence Report  Oplions  Help

=5M Type 1 Ear »

3GPP HandS Marraw » 3GPP Echo lass wikh training

3GPP Hands Wide k 3GPP Distortion receiving

3GPP HHHF Marrow r 3GPP Receiving Handset, max. Yol

3GPP HHHF Wide » 3GPP Receiving Handset, min, Yol,

3GPP DTHF Marrow » 3GPP Receiving Handset, nom, Yol

3GPP DTHF Wide r 3GPP Idle channel noise receiving, max. vol,
Configurable Handset » 3GPP Idle channel noise receiving, nom. vol,
Configurable Handsfree  » 3GPP Distartion sending Rel, 45
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P Distartion receiving

P Sending Handzet

Fig. 23 “Standards” menu with submenu for narrow band handset tests
according to 3GPP TS 26.132.

A third possibility to start a single measurement is the button “Run
highlighted as single measurement” in the sequence menu ( see chapter 7
below).

Functionality and control of the measurement

macros

]
=]
|

Sending senzitivity [dB re 1 %/Pa]

I i
100 1000 10000
Frequency [Hz]

¥ tMeasuw=d, SLR = 95508 [ Upperimit [ Lower imit

3GPP HandS Marow Type 3.2 Low Leak &itEa CMU / CBT Sample Object

Save Curve a3 Add Enter
Save Curve az Load Curve Limit File Measurement Comment Delete Curve Create Report Cloze

Fig. 24 Example of a measurement window
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When a measurement macro is started, e.g. from the “Measurement”
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays open
after the measurement is terminated. At that time, the following functionality
is available:

LT

(A el ]

Show Cursor

Zhange Scale

[Daka Poink Size
Comrnenk

Save acreenshot as ..,

Fig. 25 Context menu of the graph window

Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button is
released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.

@Ehange Scale M =]

# MininnLmm # I aximum
| 1 EIEI.EIEI::I | 1 EIEIIIIEI.EIEI::I
" kirinnam ol =R

| S000=] | 0.00=]
Cancel ok |
dnce | /

o

Fig. 26 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the mouse.
X and Y values of the data points below the cursor are displayed.

Data Point Size

“Data Point Size” in the graph context menu opens a window in which the
size of marks at the measured data points can be specified. Moving the
mouse cursor over one of the marks causes the associated X and Y values
to be displayed.
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Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear in
the report about the respective measurement.

Storing a Hardcopy of the Graph

With the menu item “Save Screenshot as ...” in the graph context menu, a
hardcopy of the current graph window with all numeric displays, legend etc.
can be stored as image. The current view of the graph including additional
curves, current scaling and size is copied. However, colours are inverted to
a printer-friendly colour set.

0
SLR=953dB _|Pass Frequency Re;ponse Iv:argm |= 5.0|9 dB‘ i Pélsls_
_,—A_
= 10 / \
/ - —
z / AT T \
/ _ \
% 20 / = \- \
LS al |
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| 1
a0 1000 10000
Frequency [Hz]

W Measured, SLR = 9.89 dB ,/T/ Upper limit W Lawwer limit

Fig. 27 Hardcopy of measurement graph

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according
to the specification of the test. Loudness ratings and other result values like
total noise level are calculated and displayed in the legend. The additional
curves and results will appear in the report if item “Store results of further
measurements” had been activated before the measurement was started.
However, limits are not checked for additional measurements.

This function can e.g. be used to find the correct volume setting to pass
nominal RLR. It can further be used for adjustments in the device under
test.

Storing and Loading Curves

All curves in the graph can be stored to an ASCII file (*.tra), and such
curves can be loaded back into the graph. For easy import to Excel the csv
format is also offered. The softkey “Store Curve” opens a window in which a
combo box offers choice between the legends of all curves in the graph.
The curve associated in which the selected entry is stored to the file with
the specified format at the specified location.

If the “Options” menu item “Store loaded curves to results database” is
checked, loaded curves are stored together with the measurement results
and will appear in reports about the measurement.
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Frequency response curves may also be stored as (relativel) UPL-
compatible trace files.

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices for
evaluation purpose.

Deleting Additional Curves in the Measurement Graph

By pressing or clicking “Delete Curve”, an additional curve in the
measurement graph can be removed. A window pops up with a combo box
in which the curve to be deleted can be selected. Note that it is not possible
to delete the curve of the first measurement, as this is the measurement for
which the verdict is given. The selected curve disappears from the graph on
the screen and is removed from the database such that it does not appear
in reports anymore.

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K9 main window. All relevant data associated with
the measurement is imported to the results data. A new entry appears for
the measurement as new row on the bottom of the overview data grid in the
main window.

Notes on Handset Measurements

Sending Frequency Response and Loudness Rating

(“3GPP Sending Handset”)

Sending Frequency Response

The sending frequency response is specified as the transmission ratio in dB
of the voltage at the decoder output to the input noise pressure at the
artificial mouth.

The mobile phone under test is installed in the LRGP (loudness rating
guard-ring position) according to ITU-T P.76, and the receiver is sealed to
the artificial ear.

Tones with a sound pressure of -4.7 dBPa are created with the artificial
mouth at the MRP (mouth reference point), and the corresponding output
voltage is measured at the CMU speech decoder output and evaluated.

The sending frequency response must be within the limit lines specified
according to table 1 of 3GPP TS 26.131. The absolute sensitivity is not yet
taken into account.
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Table 1 Limit lines according to table 1 of 3GPP TS 26.131

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -12

200 0

300 0 -12

1000 0 -6

2000 4 -6

3000 4 -6

3400 4 -9

4000 0

The offset of the measured frequency response to the upper or lower limit line is
calculated and then the whole limit template is shifted to be centered with
respect to the measured curve. Then another limit check is performed. If the
shifted curve is now within the limit lines, PASS is output, otherwise FAIL is
displayed. The limit check is performed at each measured frequency. If the
measured value and the end point of a limit line are not at the same frequency, it
may happen that the trace slightly crosses a corner of the limit line although
there are no limit violations. The remaining margin is displayed. A negative
margin shows the amount of limit violation.

Sending Loudness Rating

The sending loudness rating (SLR) takes into account the absolute
loudness in the transmit direction and weights the tones in compliance with
the normal sensitivity of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 are evaluated according
to table 1 of ITU-T P.79.

Table 2 Frequencies (Hz) of bands 4 to 17 acc. to table 1 of ITU-T P.79

200 1000
250 1250
315 1600
400 2000
500 2500
630 3150
800 4000

The sensitivity at each frequency is defined as the ratio dBV/Pa referenced
to the rated internal level in dBmO, and the sending loudness rating is
calculated according to formula 5-1 of ITU-T P.79. Note that loudness rating
values are loss values, i.e. a high loudness rating values indicates a low
gain and a low loudness rating value indicates a high gain.

Due to the input sensitivity tolerance of the CMU speech coder, the
individual sensitivity of the CMU used has to be taken into account in order
to calculate the sending loudness rating (see calibration routines).
According to 3GPP TS 26.131, the sending loudness rating should be
between 5dB and 11 dB, with lower dB values corresponding to greater
loudness (5 dB = maximum loudness, 11 dB = minimum loudness). The
measured SLR is indicated in a window in the frequency response display
and checked for compliance with these limits. In addition to the numeric
value, either PASS or FAIL is displayed.
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The general PASS or FAIL information is obtained from the limit check of the
frequency response curve and the loudness rating. PASS is output only if both
the curve and the loudness value are within tolerances.

®BGPP Sending Handset = =] E3
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Fig. 28 Sending frequency response with SLR value displayed
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Receiving Frequency Response and Loudness Rating

(“3GPP Receiving Handset, nom. Vol.”, “3GPP Receiving Handset, max, “.
Vol.” 3GPP Receiving Handset, min. Vol.”)

The following three measurement definitions are available, as the
permissible limit values of the loudness rating depend on the volume set in
the mobile phone under test: “3GPP Receiving Handset, nom. Vol” checks
loudness rating limits for nominal loudness setting and at the same time
compliance with the frequency response limit template. “3GPP Receiving
Handset, max. Vol.” checks the receiving loudness rating at the highest
volume setting against a minimum. “3GPP Receiving Handset, min. Vol.”
checks the receiving loudness rating at the lowest volume setting against a
maximum. (Note: As the loudness rating is a loss value, a high RLR is
associated with a soft speech signal and a low RLR is associated with a
loud speech signal).
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Receiving Frequency Response

The receiving frequency response is specified as the transmission ratio in
dB of the sound pressure in the artificial ear to the input voltage at the
speech coder input of the CMU. The measured sound pressure is
referenced to the ear reference point (ERP). For ear type 1, the measuring
microphone is directly applied to the ERP and no further correction is
required. For ear types 3.x, the measuring microphone is applied to the
drum reference point (DRP), which is the reason why any measured value
has to be converted to the ERP by means of calibration factors. According
to 3GPP TS 26.132, the measurement may be referenced to the drum
reference point (DRP) even in special cases. For this purpose there are
separate measurements supplied with R&S UPV-K91.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS. In case of ear type 1, the receiver is sealed to knife edge of the
artificial ear. In case of ear type 3.2, the receiver is sealed to the rubber
gasket of the artificial ear. If the low leak version of this ear type is used,
care must be taken that the defined leak opening at the circumference of
the artificial ear is not accidentally covered.

The speech coder is driven such that tones with a system reference level of
-16 dBmO are obtained. The sound pressure in the artificial ear is measured
and evaluated.

Ear type 1 will no longer be used for measurements on 3GPP mobile
phones. Therefore, 3GPP TS 26.131 defines limit values only for ear types
3.x, whereas the limit values specified in 3GPP TS 51.010 (previously GSM
11.10) are still valid for ear type 1.

Table 3 Limit lines according to table 30.2 of 3GPP TS 51.010 (ear type 1)

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -10

200

300 2 -7

500 * -5

1000 0 -5

3000 2 -5

3400 2 -10

4000 2

* Intermediate values are obtained by drawing a straight line between the specified values
and using a logarithmic frequency scale and a linear dB scale.

Use tests “3GPP GSM Rel. 4 Receiving Handset, nom. Vol”, “3GPP GSM
Rel. 4 Receiving Handset, max. Vol’, “3GPP GSM Rel. 4 Receiving
Handset, min. Vol” for receiving tests with type 1 artificial ear.

When ear type 1 is used, the receiving frequency response must be within
the limit lines specified in table 30.2 of 3GPP TS 51.010. When ear type 3.x
is used, it must be within the limit lines specified in table 2 of 3GPP TS
26.131. In the frequency response curve, the limit template is shifted to be
centred with respect to the displayed absolute sensitivity.
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Table 4 Limit lines according to table 2 of 3GPP TS 26.131 (ear type 3.x)

Frequency (Hz) Upper limit (dB) Lower limit (dB)
70 -12

200 2

300 * -9

500 * *

1000 * -7

3000 * *

3400 * -12

4000 2

* Intermediate values are obtained by drawing a straight line between the specified values
and using a logarithmic frequency scale and a linear dB scale.

The margins of the measured frequency response to the upper and lower
limit lines are calculated separately, and then the whole template is shifted
such that the resulting margins to upper and lower limit are equal. Then
another limit check is performed. If the shifted curve is now within the limit
lines, PASS is output, otherwise FAIL is displayed. The limit check is performed
at each measured frequency. If the measured value and the end point of a limit
line are not at the same frequency, it may happen that the trace slightly crosses
a corner of the limit line although there are no limit violations. The remaining
margin is displayed. A negative margin shows the amount of limit violation.

Receiving Loudness Rating

The receiving loudness rating (RLR) takes into account the absolute
loudness in the receive direction and weights the tones in compliance with
the difference between an average speech spectrum and the normal
threshold of hearing in quiet of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 are evaluated according
to table 1 of ITU-T P.79.

Table 5 Frequencies (Hz) of bands 4 to 17 acc. to table 1 of ITU-T P.79

200 1000
250 1250
315 1600
400 2000
500 2500
630 3150
800 4000

The sensitivity at each frequency is specified as the ratio dBPa/V
referenced to the rated internal level, and the receiving loudness rating is
calculated according to formula 5-1 of ITU-T P.79.

Due to the input sensitivity tolerance of the CMU speech decoder, the
individual sensitivity of the CMU used has to be taken into account in order
to calculate the receiving loudness rating (see section “Calibration” above).

The receiving loudness rating depends on the receiving loudness set on the
mobile phone under test and, according to 3GPP TS 26.131, should be
between -1 dB and +5 dB at a rated loudness setting, with lower dB values
corresponding to a higher loudness.
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The RLR must not fall below -13 dB when maximum loudness is set on the
mobile phone. To prevent damage to the human ear, the maximum
receiving loudness must not exceed a certain value.

The measured RLR is indicated in a window in the frequency response
display and checked for compliance with these limits. In addition to the
numeric value, either PASS or FAIL is displayed.

With “3GPP Receiving Handset, nom. Vol”, the general PASS or FAIL
information is obtained from the limit check of the frequency response
curve and the loudness rating. PASS is output only if both the curve and the
loudness value are within tolerances.

“3GPP Receiving Handset, max. Vol checks only the RLR against a
minimum of -13 dB. The frequency response curve is shown for information
only.

“3GPP Receiving Handset, min. VoI’ checks the RLR against a maximum
of +18 dB.
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Fig. 29 Receiving frequency response with RLR value displayed
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Sidetone Masking Rating (STMR)
(“3GPP STMR, LRGP Method”, “3GPP STMR, HATS Method”)

The sidetone path is the deliberate output of a part of the signal picked up
by the microphone to the phone's receiver. This is to create a natural
hearing impression for the person speaking on the phone as is encountered
under normal conditions involving an acoustic path between mouth and ear.

Up to release 7.0 the STMR can only be measured according to standard
using ear type 3.2 (low leakage) (“3GPP STMR, LRGP Method”). Up to
release 4, ear type 1 may alternatively be used for 3GPP TS 51.010 only
(“3GPP GSM Rel. 4 Sidetone Masking Rating”). For these tests the mobile
phone under test is installed in the LRGP (ITU-T P.76), and the receiver is
sealed to the artificial ear.
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From release 7.1 it is also possible to use ear type 3.3 or 3.4 for this test.
“3GPP STMR, HATS Method, Nom. VoI’ has to be passed in the nominal
setting of the user volume control. “3GPP STMR, HATS Method, All Vol.
Steps” has to be passed in all (other) settings of the volume control.

The artificial mouth generates tones with a sound pressure of -4.7 dBPa at
the MRP (mouth reference point), and the sound pressure is measured in
the artificial ear.

The attenuation of the sidetone path is determined at each frequency
according to table 1 of ITU-T P.79, and the sidetone masking rating (STMR)
is calculated according to formula 5-1 of ITU-T P.79 with the weighting
factors of table 3 of ITU-T P.79 taken into account. In addition, the gain of
the sidetone path is displayed as a curve.

When the phone is set to nominal receiving loudness, the STMR should be
within 13 dB and 23 dB according to 3GPP TS 26.131 when the LRGP
method is applied. With the HATS method, the target STMR is between
12 dB and 20 dB at nominal volume setting. At all other volume settings, the
STMR must not be below 8 dB with the HATS method.
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Fig. 30 Typical measurement of sidetone masking rating

Enter

Comment Dlise

Limit File: MeasLrement (e R

Save Curve a5 | Add

| Delete Curve:

Echo Loss (TCLw)
(“3GPP Echo loss with training”)

The echo loss is the attenuation between the speech coder input and the
speech decoder output (gain of speech coder + decoder = 1). Normally the
echo loss is caused by internal acoustic coupling between the telephone
receiver and the microphone. Since the echo considerably reduces the
sound transmission quality, it must not exceed a certain value.

The mobile phone under test is suspended in free air in the anechoic test
chamber (previous specifications used the LRGP).

A modulated multitone signal according to ITU-T P.501 is generated as a
test signal and applied to the speech coder. First, the spectral energy
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distribution of the generated signal is measured in the third-octave bands
from 200 Hz to 4 kHz. Then, the spectral distribution in the output signal of
the speech decoder is measured. The echo loss is calculated from the
differences of the bands according to ITU-T G.122. According to 3GPP
TS26.132, the mobile phone under test has to be fed for approx. 10 s with
the male and female version of artificial voice according to ITU-T P.50 prior
to this measurement. This training sequence is to facilitate optimization for
potential echo cancellers. A quicker test without training sequence is
available as “3GPP Echo loss without training”.

The actual gain of the speech coder and decoder must also be considered in
the result. This value is available in the CMU after calibration of the coder. In
addition, the attenuation of the echo path is displayed as a curve.

3GPP TS 26.131 specifies an echo loss of at least 46 dB; mobile phones
with good echo cancellers can meet this requirement. Since the
microphone of the mobile phone under test also picks up any side noise
and treats it like an echo, it is essential that the test chamber is well
shielded against external noise.
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Fig. 31  Typical result of echo loss measurement
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Stability Margin
(“3GPP Stability margin”)
The stability margin is measured to test the susceptibility of the phone to

acoustic feedback and instability.

For the test, the telephone is placed on an even, hard board with the
receiver and microphone pointing downwards.

A loop is closed in the R&S UPV between the receiving and the voice
channel, and an overall gain of 6 dB is set. The gain of the coder is
automatically taken into account (see also Echo Loss).

To activate the loop, a noise signal of -10 dBmO in line with ITU-T O.131 is
applied for 1 s and then switched off, with the loop remaining closed.
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Fig. 32 Window during stability margin test
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The test person has to listen to determine whether any resonances or
oscillations are produced. If there are no oscillations, the minimum
requirements according to 3GPP TS 26.131 for a stability margin of 6 dB
are met.

Sending Distortion

(“3GPP Distortion sending, Rel. 4/5”, “3GPP Distortion sending, Rel. 6”)

The SINAD ratio in the transmit path is measured as a function of the sound
level.

A pulsed sinusoidal tone of 1015 Hz with a pulse length of approx. 340 ms
is used for the measurement. At this frequency, coding yields a sufficiently
stable output signal. Voice recognition continues to be active in the mobile
phone under test due to this pulsating signal.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The test signal is generated with the artificial mouth at the MRP (mouth
reference point) and the SINAD value of the received signal is measured at
the CMU decoder output.

The acoustic reference level (ARL) is defined as the sound pressure which
creates a signal level of -10 dBmO in the transmit channel. An automatic
routine varies the sound pressure at the artificial mouth until the desired
level is attained. This value is then used as a reference for determining the
SINAD value versus level.

The SINAD value is measured at sound pressures between -35 dB and
+10 dB relative to the acoustic reference level (ARL) and compared with the
limits specified in table 7 of 26.131 of 3GPP.
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Signal processing of a modern mobile phone comprises a voice activity
detector which determines whether a voice signal is present or whether the
sending signal just comprises background noise. With such mobile phones
the sending distortion test according to 3GPP TS 26.132 before release
6.0.0 may be failed at low levels because the 1 kHz sinewave test signal is
classified as background noise and suppressed. For this reason the
sending distortion measurement according to release 6.0.0 and onwards
omits levels below -25 dB and starts at high test tone levels gradually
reducing the level. For this release, use “3GPP Distortion sending, Rel. 6”,
for earlier releases use “3GPP Distortion sending, Rel. 4/5”.

Table 6 Limit lines specified in table 7 of 3GPP TS 26.131

dB relative to ARL | Level ratio
-25dB 26.6 dB
-20 dB 30.7dB
-10 dB 33.3dB
0dB 33.7dB
7 dB 31.7dB
10 dB 25.5dB

The measurement is performed up to a maximum sound pressure of 10 dBPa
at the artificial mouth if the value 10 dB relative to ARL with 10 dBPa cannot be
attained. The actual trace may therefore end at a lower pressure. This occurs
for mobile phones under test which have a low sensitivity in the transmit

direction.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.
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Receiving Distortion

(“3GPP Distortion receiving”)

The SINAD ratio in the receiving path is measured as a function of the acoustic
signal level.

A pulsed sinusoidal tone of 1015 Hz is used for the measurement. At this
frequency, coding yields a sufficiently stable output signal.

Voice recognition continues to be active in the mobile phone under test due
to this pulsating signal.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The test signal is applied to the input of the CMU speech coder, and the
SINAD value of the sound pressure in the artificial ear is measured with
psophometric weighting according to ITU-T G.714.

The SINAD value of the sound pressure is measured at levels between
-45dBm0 and 0 dBmO and compared with the limits given in table 8 of
3GPP TS 26.131.

Table 7 Limit lines specified in table 8 of 3GPP TS 26.131

Level Level ratio
-45 dBm0 17.5dB
-40 dBmO 22.5dB
-30 dBmO 30.5dB
-20 dBmO 33.0dB
-10 dBmO 33.5dB
-3dBm0 31.2dB
0dBmO 25.5dB

The measurement is performed up to a maximum sound pressure of
10 dBPa in the artificial ear; the actual trace may end at an earlier point.

If the operator desires to see the receiving distortion value at the point
exceeding 10 dBPa, this can be achieved by pressing the “add
measurement” button. This causes the measurement to be repeated at all
specified levels. The second measurement is not taken into account for
reporting and Pass/Fail decision.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.
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Idle Channel Noise Sending
(“3GPP Idle channel noise sending’)

The noise voltage at the speech decoder output is measured with the
phone set up in a quiet environment (<30 dB(A)).

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The decoder output voltage is measured, weighted and recalculated for the
internal level in dBmOp.

For the narrow band test, the weighting is done psophometrically according
to ITU-T G.223. For the wideband version of the test, A weighting according
to IEC 60651 is applied.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied. The noise level is measured during the signal
pauses. The voice activity decoder (VAD) is activated and the mobile phone
remains in the active normal sending mode.

The idle noise level should not exceed -64 dBmOp. The measured noise
voltage is also displayed as a spectrum, making it easier to find causes if
the limit value is exceeded.
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Fig. 35 Typical result of sending noise measurement
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Idle Channel Noise Receiving

(“3GPP Idle channel noise receiving, nom. Vol”, “3GPP Idle channel noise
receiving, max. Vol”)

The sound pressure in the artificial ear is measured with the phone set up in
a quiet environment.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The sound pressure in the artificial ear is measured with A-weighting on.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied to the speech coder input. The noise level is
measured during the signal pauses. The voice activity decoder is activated
and the mobile phone remains in the active normal receiving mode.

With rated loudness set on the mobile phone, the sound pressure should
not exceed -57 dBPa(A). In this case use test “3GPP Idle channel noise
receiving, nom. Vol”.

At maximum receiving loudness, the sound pressure should not exceed
-54 dBPa(A). In this case use test “3GPP Idle channel noise receiving, max.
Vol”.

The measured noise voltage is also displayed as a spectrum, making it
easier to find causes if the limit value is exceeded.
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This measurement makes high demands on the sound insulation of the test
chamber and the S/N ratio of the measuring microphone including
preamplifier in the artificial ear. A comparison measurement with the test
mobile phone switched off or without a DUT shows the measurement
reserves of the test equipment. Due to the inherent noise of the Audio
Analyzer R&S UPV, measurements can be made to about -80 dBPa(A) at
0 dB microphone gain, and even to lower values when a higher microphone
gain is set.

Ambient Noise Rejection

Ambient noise rejection describes the weighted ratio of voice signal
transmission to noise in the environment. An ANR value >0 dB means that
voice as the useful signal is transmitted more loudly than any ambient
noise. The minimum requirement according to 3GPP TS 26.131 is
ANR > -3 dB. A value >= 3 dB should at least be attained.

To perform this measurement, a homogeneous noise field for simulating
the noise in the environment has to be generated. This sound field must be
generated by additional loudspeakers and noise generators. To obtain a
sufficiently homogeneous sound field, several uncorrelated generators and
loudspeakers are required. The use of 2 to 8 generators and loudspeakers
is common practice. The noise sources have to generate pink noise
(spectral power density ~ 1/f). The permissible error in the relevant third-
octave bands must be smaller than +3 dB with the frequency response of
the loudspeakers used also being taken into account.

This adjustment and testing of the sound field is done as a calibration
process (see section 4 above). With sufficient long-term stability of the
noise generators and loudspeakers it can be used for a number of
subsequent tests. Alignment of the noise field has to be repeated if anything
in the setup of the noise sources (loudspeaker position, amplifier gain etc.)
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is changed. Furthermore it is recommended to check the noise field in
regular intervals.

After the noise field calibration, the artificial mouth and the artificial ear
must be installed again for the actual measurement of ANR. The MRP must
be installed at the same position as the reference microphone had during
the calibration of the noise field.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS (ITU-T P.58). If installed on the LRGP, the receiver is sealed to the
artificial ear.

Set up a call to the CMU and set the bit stream to "Handset Low" (GSM) or
the dedicated channel voice to "Speechcodec Low" (WCDMA).

At first the noise spectrum picked up by the phone and sent on the uplink is
measured. After completion of the measurement, the request to switch off
the noise field will be displayed on the screen. If this is confirmed, the
speech sending sensitivity will be measured automatically and the ANR
value will be calculated afterwards.

The ANR value must exceed -3 dB.
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Fig. 37 Typical result of ambient noise rejection measurement
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The graph displays the difference of the room noise sensitivity and the
speech sending sensitivity (DELSM) for information.

Notes on Hands-Free Measurements

General Remarks
The standards 3GPP TS 26.131 and TS 26.132 define requirements and

test specifications for the tests of the acoustic behaviour of the mobile
phone in this mode, but not all details are specified yet.
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UPV-K91 3GPP Mobile Phone tests provide test cases for handheld hands-
free and desktop hands-free mode with narrow band and wideband speech.
Test specifications and limits for hands free car kits are the same as for
desk top hands-free terminals.

Hands-free tests with UPV-K91 support the use of either artificial mouth
according to ITU-T P.51 together with a free field measurement microphone
or alternatively the use of a HATS with type 3.3 or 3.4 artificial ear and
artificial mouth according to ITU-T P.58.

Test Setup

All tests must be performed in an anechoic room. Background noise must
be less than 24 dBSPL(A). Furthermore the room should be big enough and
its walls should have sufficient absorption to provide nearly free-field
conditions at the hands-free reference point. Not all test boxes which are
appropriate for handset tests can be used for hands free measurements.

If a free-field microphone with a discrete P. 51 mouth is used, it should be
configured to the Handheld hands-free UE as per Figure 12 for receiving
measurements and Figure 13 for sending measurements. The
measurement instrument should be located at a distance dyr from the
centre of the visual display of the mobile station. The distance dyr is
specified by the manufacturer.
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Fig. 38 Configuration of handheld hands-free UE, free-field microphone
for receiving measurements
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Fig. 39 Configuration of handheld hands-free UE, free-field microphone
for receiving measurements
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If a HATS is used, the measurement can either be performed binaurally
(with two artificial ears and correction of the RLR by 6 dB) or monaural.

The selection of acoustic accessories used for the hands free tests can be
entered in menu item “Options = Hands free settings”.

Hands Free Settings

LRGP ITU-T P.51 and free field
microphone

HaTs [TU-T P.58 and type 3.3
artificial ear, monaral

HaTs [TU-T P.58 and type 3.3
artificial ear, binaural

HaTs ITU-T P.58 and type 3.4
artificial ear, monaral

HaTs ITU-T P.58 and type 3.4
artificial ear, binaural

Generc speaker and free field
microphone

Cancel k. /L
2

Fig. 40 Hands free settings

b s ',
HATS y i
Reference I Normal vector
Point | from front of phone

Fig. 41 Configuration of handheld hands-free UE with HATS
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For desk top hands-free it is referred to ITU-T P. 340 (http://www.itu.org) for
the use of free field microphone and discrete P.51 mouth. The hands free
terminal should be placed on a table of approximately 1 m? with the centre
of its front edge 400 mm perpendicularly from the centre of the front edge
of the table. The surface area should not be less than 0.96 m” and its width
should not be less than 0.8 m. The front centre of the measuring
microphone or centre of the lip ring, respectively, should be placed 300 mm
above the centre of the front edge of the table with the axis of the
microphone or artificial mouth inclined towards the centre of the front edge
of the hands-free terminal.

For the use of a HATS with both types of hands-free terminals it is referred
to ITU-T P.581. For handheld hands free the setup of ITU-T P.581
corresponding to “portable hands-free” should be used. For desk top
hands-free, the centre of the lip ring is positioned as described above, but
the axis of the artificial mouth should be horizontal.

Acoustic Calibration for Hands Free Tests

The calibration for the free field microphone or type 3.3 or type 3.4 HATS
ear, respectively, is done as described in chapter 4 above.

For binaural measurements, the second artificial ear has to be calibrated
accordingly, using the sub-item “Second Type 3.3 ear” or “Second type 3.4
ear”, respectively, in “Calibration - Artificial Ear’. Note that the second
artificial ear must be connected to Analyzer input 2 instead of the CMU
connection.

According to 3GPP TS 26.132 free field equalization has to be taken into
account. Free field data can either be imported as an average table from
the standard or from an individual calibration disk, using the menu item
“Calibration - Free field equalization”.

The calibration of the artificial mouth for hands free tests comprises two
additional steps. After the level has been adjusted and the frequency
response has been equalized at the MRP, the reference microphone has to
be repositioned at the so-called Hands-Free Reference Point (HFRP or
HATSHFRP).

For the mouth according to ITU-T P.51 the HFRP is in 50 cm distance from
the lip ring on the axis of the mouth. The calibration has to be performed at
this point independent of the measuring distance currently used.

The HATS HFRP is stipulated in ITU-T P.581. It is one of the points 11 to
17 defined in table 6a of ITU-T P.58. It should be on the axis which is
closest to the actual axis from the lip ring to the microphone under test. The
distance is always 50 cm from the lip ring. The axis may be azimuthally
centric (i.e. 0° horizontally) with an elevation (vertical) angle of 0°, +15° or
1+30°. Points 16 and 17 are located on an axis with 0° elevation and an
azimuth angle of 15° or 30°.

The level at this point is adjusted to -28.7 dBPa. For the last step, the
reference microphone is returned to the MRP, and the level and spectrum
at the MRP are measured as reference for the transfer function calculation.

The mouth calibration for hands-free tests is started with the menu item
“Calibration > Atrtificial Mouth (Hands Free)”. This procedure comprises the
mouth calibration for handset tests and has also effect on subsequent
handset tests with the same individual artificial mouth.
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“Utilites” Measurements

This item of the “Standards” menu contains useful measurements which
are either from other standards or for checking test conditions.

Sidetone Distortion

A sidetone distortion test is specified in 3GPP TS 51.010 30.8 for
measurements using the DAI. As the downlink conveys only silence during
this test, it is more or less independent of the kind of transmission between
system simulator and mobile. The sidetone distortion test determines 3"
order harmonic distortion at a given set of frequencies (in the case of
TS 51.010 at 315, 500 and 1000 Hz) with a level of -4.7 dBPa at the MRP.
The third order harmonic distortion is required to be less than 10 % (-20 dB)
at all frequencies.
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Fig. 42 Sidetone distortion test
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Gain Variation Tests

Gain variation tests in sending and receiving direction are specified in 3GPP
TS 43.050 Annex C.5. The limits given in TS 43.050, sections 3.9.1 and
3.9.2 are meant for measurement over DAI and cannot be fulfilled when a
Codec is in the transmission chain. The configurable versions of the gain
variation tests allow to define specific limit curves.

< sending Gain ¥ariation, 3GPP ] 3
10

=1

Sending gain variation [dB]

20 ) I I I ) I 1
A0 -4 -30 20 10 0

E : 10 20
Sending signal level [dB relative ta ARL]
m Measured
36PP Hands Namow | Type 3.2 Low Leak AtEa | CMU / CBT |5 ampie: Object [
Save Curve az | Load Curve Safrﬁfﬁ: as | Meai?edmenl EnEr;ﬁ;nt Delete Curve Create Report Cloze

Fig. 43 Sending gain variation test
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Delay Measurements

Sending and receiving delay can only be measured end-to-end, i.e. from the
acoustic origin of the artificial mouth to the decoder output of the system
simulator or from the encoder input of the system simulator to the DRP.
The measurements offered with R&S UPV-K91 allow to subtract the
estimated delay of the CMU from the total measured value. As the data is
interleaved on the air interface, no exact time instance can be determined
when the audio data are transmitted between mobile phone and system
simulator. The values used in the present measurements are estimations
with an uncertainty of about 10 ms. The delay measurement is performed
for a given set of frequencies, and an average is calculated over all
frequencies.

®5ending Delay CMU 1=l

85

80

Sending delay [ms]
=]

@
=

50

45 I i
100 1000 10000
Frequency [Hz]

m Measured, Average = B5.3 mg

36PP Hands Namow | Type 3.2 Low Leak AtEa | CMU / CBT |5 ampie: Object [

Save Curve as | Load Curve

Enter
Comment

Save Curve a5 | Add

Limit File e Delete Curve Create Report Cloze

Fig. 44 Sending delay measurement
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Background Noise Measurements

3GPP TS 26.132 demands the background noise in the test room to be
below -64 dBPa(A) for idle channel noise measurements and below
-30 dBPa(A) for all other handset measurements. For hands free
measurements the background noise needs to be below -70 dBPa. The
background noise measurements offered in R&S UPV-K91 check the
overall noise level against these limits and display the spectrum of the
noise. A lower limit assures that the test is not erroneously passed if no
microphone is connected or the microphone supply is switched off.

@Batkgrnund noise 3GPP, general =]
-E0

70
-B0

-90

A-weighted spectrum [dB]

-100

10 -8

I 1 i
20 100 1000 10000 20000

Frequency [Hz]

B teasured, Naise = -53 05d8Pa(2)

‘BGPF' HandS Marmrow |D\ffuse field microphone ‘CMU /CBT |Samp\e Object |

Save Curve as | Load Curve

Fig. 45 Background noise measurement

Enter
Comrment

Save Curve as Add
Lirvit File Measurement

Delete Curve Create Report Close

If the noise in the test room does not fulfil the requirements it may first be
attempted to remove noise sources in the vicinity of the test chamber. If no
further reduction is possible, the sound isolation of the chamber should be
improved. This can be achieved e.g. by heavier walls. Low frequency noise
may possibly be conducted as structure borne sound, which may be
reduced by an isolating support of the chamber. High frequency noise can
be caused by a leakage e.g. at the door and may be reduced by an
improved gasket.
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7 Customizing Measurements
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Measurements which implement a test case of a standard are locked and
cannot be edited. However, for each measurement type there is also a
configurable measurement provided, in which the limits can be customized.
The parameters of the measurements are accessible through the menu
item “Config. Meas.”

|CDnFig.Meas. Sequence  Repork  Options  Help

Configurable Handset armbient Maoise Rejection with Modulated Mulkisine
Configurable Handsfree  » Echo loss with modulaked mulkising
Receiving Handset with madulated rulkisine

BCENING

i Sidetone Masking Rating with Modulated Multisine
- Sending with modulated multisine

eceiving

Peak Acoustic Pressure Level with Signal "PeakLewvel"
Distartion receiving

Idle channel noise receiving

Distortion sending

Idle channel noise sending

Skahility rarain

Sidetone Distorkion {generic)

andset wideband
zending wideband
andset wideband
andset wideband
andset wideband
andset wideband

zending wideband

Sending Gain Yariakion
Receiving Gain Yariakion
Sending Delay

andset Receiving Delay

_ Background noise measurement (generic)

Fig. 46 Measurement configuration menu

zending wideband
eceiving

Clicking on one of the entries opens a window in which all parameters can
be viewed and most of them can be customized:

Parameters of Sending with modulated multisine

Template Files

Sen: th modulated multising Mo File Mame | Type | Uppermargin[dB]  Lower margin [4B

Descripbion 1 3GPP_Handset_Sending N Mandatoy up 0 1]
Measulemanlnlrecelvlng_senslhwtyhequenl:y -~ 2 3GPP_Handset_Sending N Mandatary lo 0 1]

response and loudness rating, using modulated
multigine according ta ITU-T P.501
[ |
Add Number [ 1= Delete Edit |
0741242006 12:31:03 Parameters
Operator instruction Mo/ Name | Type | Default Yalud Fixed
‘| 1 wideband Bodlzan falss | False
2 SLRA upper limit [dB) Double 11|False
3 check SLR upper limit Boolean true| False
4 SLR lower limit [dB] Double 5 False
5 check SLR loveer limit Bodlean true False

Program File
SFR_tMS

I

an File name

1/3G zending responze. set

Humber m Edit |
Momber [ 7= Eat | [T Locked Cancel

Fig. 47 Measurement parameters window
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As Sequences create copies of the parameter files, each instance of a
measurement in a sequence can have different settings which remain
independent of the setting of this measurement in the main window and in
other sequences. It is for example possible to compile a sequence with a
number of stability margin tests having different loop gain.

The titles of the tests and the messages displayed to the operator before
start of the measurement can also be edited in the “Parameters” window.

Editing Parameters

Parameters can be edited by entering their number in the “number” field
below the data grid and clicking “Edit”.

Murnber I o

M ame

SLE upper limit [dB]

Type

I Drouble j

Default Walue

|11

[ Locked

Cancel | Ok I
Y

o

Fig. 48 Entry window for parameters

Note that the type conformity of the entered value is checked, but not the
value itself against any range limits.

Editing Limit Curves

Clicking “Add” or “Edit” below the data grid for the limit curves opens the
window for selecting limit files.

Note that currently only “mandatory” limit curves are supported. Most of the
measurement allow to specify either lower limits or upper limits or both. An
exception is formed by the sending response and receiving response
measurements. As the limit template is centered around the measured
curve with these measurements, upper and lower mandatory limits have to
be specified pair-wise.

An exiting limit file can be selected using the “browse” button. New limit files
can be created by copying an existing limit file and editing the copy with a
text editor (“Send to > Notepad” in the context menu of the file in the
windows explorer). The number of data points on the curve must be
specified in the “Datacount” line.
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Template Curve
Mumber |3
M andatary upper limit

Mandatory lower limit

Dresired upper limit
D esired lower limit

Center curve

Upper tolerance Lower
dE tolerance di

=] [ |

File name: Browse
Cancel | Dk I

Fig. 49 Entry window for selecting limit curves
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8 Measurements with electric connections
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Introduction

Usually the mobile under test is connected via RF connection to the CMU
and via acoustic interfaces (artificial mouth and ear) to the R&S UPV.
Therefore no intrusion in the mobile device is required.

There may, however, be cases during the design process of a mobile
phone where the usual interfaces are not available:

- if a mechanic mockup is to be measured just with the acoustic
components but without the rest of the circuitry

- if a circuit of a mobile phone is to be measured without acoustic
components

- if a hands free kit or headset is to be measured without mobile phone

- if the hands free or headset connection of a mobile phone is to be
measured without hands free kit or headset, respectively.

In these cases either coder and decoder or artificial ear and artificial mouth
may be replaced by direct electrical connections to the R&S UPV. To use
electric connections, select “Electric connection” in the respective item of
the “Options” menu.

Calibration values for electric connections

Electrical connections cannot be calibrated. Instead a virtual sensitivity has
to be entered for each type of electrical connection under “Calibration >
Electric connections > ...".

Electric connection replacing artificial ear

R&S UPV Analyzer input 1 is directly connected to the earpiece amplifier
output.

A nominal sensitivity of the receiver (earpiece speaker) for which the circuit
is intended has to be entered in dB re 1 Pa/V.
Electric connection replacing artificial mouth

R&S UPV generator output 1 is directly connected to the microphone input
of the mobile phone circuit.

A nominal sensitivity of the microphone for which the circuit is intended has
to be entered in dB re 1 V/Pa.
Electric connection replacing encoder

R&S UPV generator output 2 is directly connected to a earpiece or headset
speaker or to the speech input of a hands free kit.

A nominal full scale output voltage (output voltage corresponding to digital
full scale) of the circuit intended to drive the speaker or car kit has to be
entered.

Electric connection replacing decoder

R&S UPV analyzer input 2 is directly connected to a microphone or to the
speech output of a hands free kit.
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A nominal full scale input voltage (input voltage corresponding to digital full
scale) of the respective microphone or speech input has to be entered.

Performing the measurements

After applying the settings in the “Options” menu and after entering
appropriate calibration values for the electric connections in use, the
measurements may be started as usual.

Some parts of the standard require the use of particular artificial ears for
particular measurements. Therefore the checkbox “Allow only selected
measurements” should be unchecked in “Options - Standard”.

For sending tests, the output voltage range in the R&S UPV is set to a large
value in order to be able to drive the speaker of the artificial mouth. In rare
cases sending distortion and/or sending noise results may be degraded
with electric connections if a low microphone sensitivity is entered. In this
case please contact R&S support.
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9 Automatic Test Sequences

1402.0043.12

5. | Sequence Report  Opl
=
Open ...

il

ezt obje

Fig. 50 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence - New” first produces a window where a name
for the new sequence has to be entered. Subsequently the sequence
window opens.

{0
1 3GPP Hands Narrow e
- 3GPP Echa loss with training .
3GPP Distartion receiving MI
3GPP Receiving Handset, max. Vol
3GPP Receiving Handset, min. Yol Delete %
3GPP Receiving Handset, nom. Vol 4|
AGPP ldle channel noize receiving, max. vo
- 3GPP |dle channel noize receiving, nam, v &I
- 3GPP Distortion sending Rel 4/5
- 3GPP Distortion sending Rel. & &I
- 3GPP Sending Handset .
- 3GPP |dle channel noige sending MI
- 3GPP Stability margin o
-+ 3GPP Sidetone M asking Fating wl
- 3GPP dmbient Moise Rejection
- 3GPP HandS Wide [Efezr |
- 3GPP HHHF Mamow
- IGPP HHHF Wide Ehiecl Al |
[ 3GPF DTHF Narrow
[ 3GPP DTHF wide [rehestk 2l |
[ Configurable Handzet
- Configurable Handsfree
Save FequUEnCce as |
4 | | _;I [Eloze |

Fig. 51 Sequence window

Initially the right checked list box is empty. The tree view box on the left side
displays all available measurement definitions structured according to the
standards, similar to their order in the “Standards” menu. A measurement is
appended to the sequence by highlighting it in the tree view box on the left
side and clicking the “Append” button. Subsequently a measurement, which
is highlighted in the checked list box on the right side, can be moved within
the sequence using the buttons “Move up” and “Move down” and deleted
from the sequence with the “Delete X" button. For non-standard
measurements which allow to change parameters like limit curves, it is
possible to edit the parameters before appending the measurement to the
sequence. This is done by clicking the button “Edit and append”. It is for
example possible to assemble a test sequence which contains stability
margin tests with different loop gains.
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Opening an Existing Sequence

The menu item “Sequence > Open ...” opens a file selector for specifying
the sequence to be loaded. The sequence file is usually found in a
subfolder of D:\3GPP with the same name as the sequence. The sequence
window opens with the specified sequence loaded. The sequence can then
be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements
in the right list box are executed in sequence. The state of the checkboxes
may be altered by marking a measurement and then clicking on the
checkbox.

A running sequence may be interrupted with the softkey “Stop / Cont
Sequence” which stops the execution after the currently running
measurement.

Running a Single Measurement out of a Sequence

A single measurement of a sequence may be started by highlighting the
measurement in the right checked list box and clicking the button “Run
Highlighted”.

Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the last
sequence can be obtained by pressing the “Report last sequence” softkey
in the main window.
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10 Reporting, Storing, Loading and Deleting Results
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Result Files

Measurement results are stored together with all associated data in XML
files. Separate files can be used for different projects or operators. They
can be archived together with other project data and re-opened later for
generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

@)Telephune Tests

File Data Calibration Measurement Seguence Report  Options  Help

Cpen results File

Save results | keasurement title

sva el ‘_35 b Fhd AGPF Receiving Handzet, nom. ol
RS T2 B P AGFF |dle channel noize receiving, nom. wo
Load settings e P AGPF Sidetone Mazking F ating
Save settings 1 P AGPF Distortion receiving
Save settings as 0 P AGPF Sending Handzet
_ H P4 AGPF Distortion sending Rel. &
2k Prd AGPF |dle channel noize zending
| | arasanne 29749 O WSPP P araivinn Handeat min Wl

Fig. 52 File menu

A new (empty) result file can be created with “File > New Result File” from
the main menu.

An existing result file can be opened with “File > Open Result File” from
the main menu.

A currently opened result file can be stored under a new name with “File >
Store results as” from the main menu.

Report Settings

With “Report > Settings” or “Options = Report settings”, a selection can be
made of data which should appear in the reports. Thus, information which is
the same for a larger number of measurements does not have to be printed
with every report again.

Generating a Single Report

A report on a single measurement result can be generated from the window
of a measurement macro by clicking or pressing the softkey “Generate
report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected result
by clicking on the row header to the left, right-clicking into the data grid and
selecting “Generate report” from the context menu.

Subsequently data associated with the selected measurement is
assembled, a graph for existing curve data is generated, and the preview
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window is opened. Depending on the amount of measurement data, this
may take a few seconds.

Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed
sequence can be generated by selecting “Report > Last sequence” from
the main menu. Reports about previous sequences can be generated as
single reports on the measurements of this sequence, as all results appear
in the overview data grid in the main window.

Preview Window

3GPP Sending Handset videband

Tatal: O3 3000

Mardactirir
S v

Commant:

Yerdick
0

Fig. 53 Report preview window

The main area of the preview window shows a preview of the report as it
will be printed or appear in an exported PDF file. If the report comprises
more than one page, the pages can be browsed using the buttons

M 4 » H

To open the print dialog for installed windows printers click

To open a file selector for export of the report to PDF, WORD, EXCEL or
Rich Text format, click
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The scale of the document in the preview can be adjusted with

|
_ |whole Page T |
banox |
300%

200%

150% o

7h% -

Fig. 54  Scale menu of the preview window

Storing and Loading Curves

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at different
times or places. Measured curves can also be stored in a R&S UPV limit
file for use as a limit curve either in a R&S UPV sweep graph or in the
graph of a R&S UPV-K9/K91 window. This allows e.g. to derive tolerance
schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.

Shift Curve by 0= db

Cancel | Ok

#

Fig. 55 Input window for defining a shift of a measured curve for storage
as limit curve

Furthermore curves can be exported from the main results window by
marking the result in the data grid, right-clicking on it and choosing the item
“Save curve of selected row as ...” in the context menu.

ASCII Result Files

When the item “Generate temporary export files” in the “Options” menu is
checked, the standard tests generate “curve.exp” or “abscurve.exp” and
“relcurve.exp” and “result.exp” files similar to those generated by UPL-B9.
These files are always deleted and overwritten by subsequent tests.

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to a missing
call to the mobile, a wrong setting etc. To delete the result of a particular
measurement, mark the row for the selected measurement in the data grid
of the main window by clicking on the row header to the left, right-click into
the data grid and select “Delete result” from the context menu. After
confirmation by the operator, the selected row of the result overview will be
deleted from the result file together with all associated data.
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11 Terminating the Application

The measurement can be terminated from the main window with the “Exit”
softkey. This causes the result file to be written to the hard disk.
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Firmware 4.52

Settings for GSM:
Selection of the GSM band:

GSMQOO Overview

Ch. 2

E Menu Select

Connect
Control

— Selection ‘GSM Mobile Stationi®eM 900/Sighaling/OverviewPit Marmal GMSK |— Hotkeys - Set 1
¥ Basic Functions ¥ Mon-Signaling -+ AnatyzersGenerator R
. - . AnalyzerfGenerator
» 3G UMTS User Equipment > Signaling + Overview ]
+ AMPS Mobile Station AUDIO
T ZS Mobile Station AnalyzeriGenerator
* GSM 400 —_—¥
« 3SM 850 WCDMA UE FDD
Power
[ - Gemono Maximum
= GSM 1800 WCDMAUEFDD [l
+ (G5 1900 Modulation
+ IMT-2000 Mobile Station WEDMATOV eI icH
» TOA Mobie Station AMPS
AnalyzeriGenerator
Modulation
AMPS H
Overview
Modulation
Enter
Menu Hotkeys Hotkeys Hotkeys Hotkey I
Select Set1 Set 2| Set 3| Assign.l

Taking a coupling loss of the antenna coupler into account:

GSMQOO Overview

Ch. 2

Connect
Control

B GSMaoo Connection Control [g Signal On
AF Connector Overview: RF Connector Setup
AT AL RF
Analyzer 2 o o Generator 2 i 9 QU 372 7] 0utput
AFIN  AF OUT Op
Analyzer 1 ° ° Generator 1 Ext. Att.
s &S +0.0 a8+15.0 uB +0.0 4B Cutput
Speech RF 41N RF 2 RF 1 RF
Encoder | Handset]3] G- Input
Speech Ext. Att.
Decoder | Handset]Y +00d6+15.0 B +0.0 dB Input
| — EWideband
Pk Power

Connection

MS Signal BS Signal | Network

nFIRF@»l Sync. |-. 2 ||
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Select EFR (full rate version 2), HR (half rate version 1), AMR full rate or
AMR half rate speech coder:

| GSMooo overview

B GSMaoo Connection Control [g

Full Rate Version 2 |
Full Rate Version 1

Full Rate Version 2

Half Rate Version 1
FullRate Data 4800
Full Rate Data 9600

Speechcod./Handset Low || |

| GSMooo overview

B GSMooo Connection Control [§ Signal On

Full Rate Version 2 ¥ |
Gl

MCST Test Mode
MCS8 Test Mode
MCS9 Test Mode
AMR FullRate

AMR Half Rate
Speechcod./Handset Low |_
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Selection of the Bit Stream Handset Low setting for the measurements or
Decoder Cal and Encoder Cal for the calibration:

| GSMooo overview

B GSMaoo Connection Control [g Signal On

Full Rate Version 2 | |

Speechcod./Handset Low || |
[G]

Speechcod./Handset

Speechcod./Handset Low

Codec Cal
Encoder Cal
Decoder Cal

| GSMooo overview

| 62 947.4 MHz
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Typical setting with EFR speech coder (corresponds to AMR 12.2) for
measurements in the call established status:

| GSMooo overview i ’

B GSMaoo Connection Control [B Call Established

Full Rate Version 2 |Ji |

Speechcod./Handset Low || |

Settings for WB-AMR:
GSMSOO Overview

B GSMooo Connection Control [ Signal On

Full Rate Version 2|
[C]

AMR Half Rate GMSK
AMR Half Rate 8BPSK

AMR-WB Full Rate GMSK

AMR-WB Full Rate 8PSK

AMR-WB Half Rate 8PSK

Speechcod./Handset Low |4
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Settings for UMTS WCDMA FDD:

Selection of mode:

| WCDMA Fop %™ Modulation

t Connect
Control

B Menu Select
— Selection ‘SG UMTS User Equiﬂ“famih\lCDMA FOCYSignalinoModulstion!. . . |— Hotkeys - Set 1
» Basic Functions » Mon-Signaling +Power RF
. - - AnalyzeriGenerator
~3G UMTS User Ecuipment |* Signaling +Modulation |
[+ WCDMAFDD Do)

+ AMPS Mobile Station AnalyzeriGenerator

+ GSM Mobile Station —_—

¥ IMT-2000 Mobie Station WCDHA LIE FDD

+ TDMA Mobile Station Maximum
WCDMA UEFDD  [F]
Modulation
WCDMA Overview
AMPS
AnalyzerfGenerator
Modulation
AMPS (|
Overview
Modulation

Enter
Menu HotKeys HotKeys HotKeys HotKey
Select Set 1 Set 2 Set 3 Assign.

Setting dedicated channel to voice:

| WCDMA Fop %™ Modulation

B WCDMArbD Connection Control

t Connect
Control

Signal On

RF Chn. Signal
Downink | 21124 miz|| 10562 |  MHaiting for ng |
e registration
or

E:Iﬁ‘rll(n. | 1922.4 MHzH 9512| call from the UE.
B

o Cutput Ch. Poiwer
UE Power Dedlcated

33.0 dBm‘ \ -20.0 |:IBm| Voice u

Control Iax. all. LE-Pow: LIL Target Power RMC Channel

|
Openloop | I |
Power E PRACH UE-CrPaw

— Voice ‘
Enter

PRACH Signature S|gna|||r'|g RAB
Operating Band |
Expect. PRACH Powr | LI seIeCt
Connection | Handover | UE Signal | BS Signal | Hetwork | AF!RFG" Sync. |.- 2 II

Selection of the Narrowband AMR Speechcodec Low setting and AMR Bit
Rate for the measurements or Decoder Cal and Encoder Cal for the
calibration (selection is possible only if call is deactivated):
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5] WCDMA ron ™4™ mosuston 58 _ T [

B WCDMAFDD Connection Control Jg PS: Idle CS: Signal On

|ircuit Switched Voice Settings/. . I

Speechcodec Low
Active Coder B AMR
a3 It Rate i
Active Codec Set Selection & Compress]
Codec Modes 4,75 kbpss
515 kbps
59 kbps
BT kbps

O
O
O
O
[ 7akops
O
O

7.95 kbps (=
10,2 kbps
12,2 kbps

¥ B Adaptive Multi Rate (A8 AMR)
~ Signaling RAE Settings

Cunnectionl Handowver | UE Signal BS Signal | Metwork | AFFRFG" Sync. |.- 2 II

3GPP Ts 26.132 specifies 12.2 kbps bit rate for audio testing with the NB
AMR codec.

Selection of the Wideband AMR Speechcodec Low setting and AMR Bit
Rate for the measurements or Decoder Cal and Encoder Cal for the
calibration (selection is possible only if call is deactivated). 3GPP TS 26.132
specifies 19.85 kbps for audio with the WB AMR codec:

@ WCDMA FDD Ba:nd Modulation

Connect
Control

B WCDMAFDD Connection Control Jg CS: Signal On

—Setup |circuit SwitchedVoice Settings |E

Y Tings |
Voice Source Speechcodec Low @ml-i
Active Coder B AMR

v Acdaptive MUt Rate (NB AMR)
B ti Rate |

Active Codec Set Selection C

Codec Modes [] Ep0khps
[ saskbes
[ ] 1265kops
[T 1425kps
[ 1585 ks =
[T 1825kmps
19,35 kbps
[ 2305k0ps
[ 2385 ko=

Connection | Handower UE Signal BS Signal | Network | AFIRFG'l Sync. |.- 3 II
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Mobile phone registered status, codec settings possible:

F WCDMA rFop Balnd Modulation é '_h ’7

B WCDMArbD Connection Control Registered

| 2112.4 muz 10562
| 1922.4 MH:z 9612

|

| | Voice[Y |
0
| q
F
OperatingBand | || |

2|

Call active (connected) status for the measurements:

Ch. 1 WCDMA Fop Balnd Modulation ’

Bl WCDMA D Connection Control [ Connected

| 2112.4 muz 10562
| 1922.4 MH:z 9612

|

| |
0

| gl = —
F

OperatingBand | || |

2|
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Appendix B Troubleshooting
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Damaged setup file is reported

Copy “Settings.sup” from C:\Program Files\Rohde&Schwarz2\UPV-K9x
Mobile Phone Tests” to “D:\3GPP”, overwriting the damaged file of the
same name. Alternatively, “D:\3GPP\settings.sup” may just be deleted.
Subsequently all settings in the “Options” menu have to re-done and for all
used calibration types calibrated devices have to be selected again.

Damaged results file is reported

There are backup files available of the file containing the test results, with
appendix ~1 and ~2 to the file name of the results file (usually
“D:\3GPP\Results.xml”). If the results file cannot be opened for some
reason, the later backup file can be renamed by removing the respective ~1
or ~2 extension, and opened subsequently. It is recommended to store the
damaged results file under a different name.

A test is not starting properly

Re-select devices for the calibration types required for the respective test,
using menu item Calibration - Select device. If this does not solve the
problem, copy all files from “C:\Program Files\Rohde&SchwarzZ\UPV-K9x
mobile phone tests\3GPP files\Overwrite” to “D:\3GPP”, overwriting the
existing files therein.

A calibration value is missing or no device is selected for
a required calibration type

If re-selecting the calibration device and re-calibrating it does not help,
create a new device with “Calibration > New device”. Tick the “Immediately
select this device” box before clicking the “Ok” button and do the calibration
for this device. All selected devices and their calibration values can be
checked with “Calibration > Show selected devices”.

The receiving noise test produces an overrange error

Reduce the gain of the conditioning amplifer in the signal path of the
artificial ear and re-try the test.

ARL for the sending distortion test cannot be adjusted

First, try a sending test to see if the connection to the mobile is existing. If
the RLR value is too high, the sending sensitivity of the mobile under test
may be too low to adjust the ARL. If there is no signal in the sending test
(SLR > 60 dB) check the connection between CMU and mobile. If no signal
from the artificial mouth is audible during the sending test, check the signal
path between R&S UPV and artificial mouth. Re-calibrate the artificial
mouth.
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Other problems of unknown reason

If the problem cannot be solved with the information given above, the folder
“D:\3GPP” can be renamed or deleted. At the next start of the application,
this folder is created anew with all files in default state.

Attention: Store a backup copy of the results file in a different folder before
deleting “D:\3GPP”.

Note: Subsequently all settings in the Options menu and all data
entries have to be re-done, all calibrated devices have to be
created and calibrated again.
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